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Chapter 1 – Course Overview
Introduction
This course covers the skills required to use DataPA OpenAnalytics to obtain data in
Excel, create Dashboards with the DataPA Enterprise Dashboard and generate
Reports using DataPA’s own report design tool. Although the course will cover the
basics of using DataPA OpenAnalytics with other applications, the emphasis is on
DataPA OpenAnalytics and how it interacts with these applications, rather than
necessarily how to use the data within those applications.

Audience
The course is intended for end users who will use DataPA OpenAnalytics as a standalone application to generate Dashboard, reports and use the Excel add-in.

Prerequisites
Users should be familiar with the Microsoft GUI Interface and have working
knowledge of Microsoft Excel.
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What are your goals?

• Think about what you would like to learn from
this course
• Introduce yourself
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Student Goals
Please take a few moments to document your own goals for this course. What will
you need to know and/or produce when you return to work?
What are the three things you most want to know about DataPA OpenAnalytics?



Please introduce yourself by answering the following questions
1. Your Name and Job

2. Your experience with Excel and reports design software

3. What you would like to learn from this course
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Course Goals

>

Create simple and complex queries using DataPA

>

Save and share those queries between applications

>

Run queries to extract data in MS Office

>

Create dashboards using the DataPA Enterprise Dashboard

>

Create reports in DataPA using DataPA queries
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Course Goals
When you complete this course you should be able to:
Create simple and complex queries using DataPA
Save and share those queries between applications
Run queries to extract data in MS Office
Create dashboards using the DataPA Enterprise Dashboard
Create reports in DataPA using DataPA queries

3

DataPA OpenAnalytics End User Training

Lesson Overview

Lesson 1:

Course Overview

Lesson 2:

Introduction to DataPA

Lesson 3:

Creating Queries

Lesson 4:

Building Dashboards

Lesson 5:

Designing Reports

Lesson 6:

Using Drill down and Sub Reports

Appendix A:

Scripting

Appendix B:

Creating Subjects

© DataPA

Lesson Overview
Lesson

What is covers

Lesson 1 - Course Overview

Introductory material about this course

Lesson 2 - Introduction to
DataPA

Introduces the DataPA file concepts. Covers using
DataPA in Excel, the Enterprise Dashboard and
DataPA Reports.

Lesson 3 - Creating Queries

A detailed look at creating queries with the query
wizard. Includes a detailed discussion of creating
query conditions in addition to covering the creation
of complex queries.

Lesson 4 – Building
Dashboards

A detailed look at using the DataPA Enterprise
Dashboard application to build dashboards. Includes
a detailed discussion of the application interface,
building tabs, objects and drill downs, and applying
filters.

Lesson 5 - Designing Reports

A detailed look at designing reports with DataPA
Reports. Covers creating reports, grouping,
formatting, special fields, printing and exporting.

Lesson 6 - Using Drill down
and Sub Reports

A detailed look at the concepts behind drill down
and sub reports, what they are used for and how to
create them.

Appendix A - Scripting

A detailed look at using scripting behind reports to
achieve more complex tasks such as conditional
formatting and inclusion of ActiveX controls.

Appendix B - Creating
Subjects

A detailed look at creating each of the three types of
subject used in DataPA.
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Chapter 2 - Introduction to using DataPA
Introduction
DataPA allows users to easily access and manipulate information from your business
systems. In this chapter we will explain operating system files that DataPA uses to
define and store information, and introduce the interfaces that allow us to use those
files to extract data into Windows applications.

Learning Objectives
When you complete this lesson you should be able to:






Explain DataPA file concepts.
Use DataPA in Excel. Open and run a query.
Use DataPA Enterprise Dashboard to open and view a dashboard.
Use DataPA Reports. Open and run a report.
Manipulate data in a report.

Prerequisites
Before you begin this lesson you should be able to:


Open a copy of Excel
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DataPA File Concepts

DataPA Query
(Customers.qpa)

DataPA Report
(Customers.rpa)

DataPA Query
(Customers.qpa)

DataPA Enterprise
Dashboard
(Customers.edp)
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DataPA Queries
In order to define the data extracts we will use from a given system, DataPA uses the
concept of a query. The query defines the following:






The system we wish to extract data from
The type of data we want to extract
Any conditions or parameters used to limit the data we receive
Which fields from the data set we wish to receive
The sort order the data will be received in

Queries are stored on disk in the form of qpa files, for example we might save a file as
C:\MyQueries\customer.qpa.

DataPA Dashboards
A dashboard can potentially contain many queries. In addition to the data extract
information defined by these queries, we need to store the dashboard layout,
formatting and behaviour definitions. As such, DataPA dashboards are stored in a
different file format, edp files. For example we might save our customer dashboard as
C:\MyReports\customers.edp. This dashboard file contains both the query, and layout,
formatting and behaviour information for the dashboard.

DataPA Reports
Like dashboards, in a report we need to store the data formatting and layout
information in addition to the data extract definition. As such, DataPA reports are
stored in a different file format, rpa files. For example we might save our customer
report as C:\MyReports\customers.rpa. This report file contains both the query, and
formatting and layout information for the report.

6

DataPA OpenAnalytics End User Training

Sharing Queries
We will see later in this course how we can share queries between applications such
as Microsoft Excel, DataPA Enterprise Dashboard and DataPA Reports.
You can create reports, and add queries to a dashboard by copying an existing query.
Any subsequent changes to the query in the dashboard or report do not affect the
existing query, as the changes are made to a copy of the query stored independently in
the dashboard or report.
Similarly, you can share a query from an existing dashboard or report, and use it in
Excel or a different dashboard or report. The shared query is a copy of the original,
and as such any changes to it do not affect the original query stored in the original
dashboard or report.
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DataPA and Excel

Menubar
Toolbar

Information

Outlook Bar

Panel
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Opening the DataPA Excel Add-In
When DataPA is installed it adds a button to the Excel toolbars to open the DataPA
Add In. If the button is missing, follow these steps:
1. From the Excel tools menu, select Add Ins
2. Make sure DataPA is checked
3. Press OK
If DataPA is not available in the Add Ins Dialog box, follow these steps:
1.
2.
3.
4.

From the Excel Add Ins Dialog box, press Browse
Browse to C:\Program Files\DataPA\Excel
Select DataPA.xla
Follow the instructions above from step 2

To open DataPA in Excel, press the DataPA button on the toolbar.

Accessing the Online Help
DataPA includes a context sensitive help system.
To access help from the main screen, select Contents from the help menu.
There are three ways to locate information in help; these correspond to the three tabs
in the Help Topics window.
Tab
Description
Contents

Expandable table of contents that allows you to search through
topics in a hierarchical arrangement.

Index

An alphabetic listing of topics. You can either browse to a topic
or enter a keyword to search.

Find

Uses a keyword-searchable database to find topics.

You can also access help topics relevant to the screen you are currently focused on by
pressing the F1 key.
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Opening a Query in Excel
To open a query, follow these steps:



From the File menu, select Open an Existing Query
Select the query file in the Open File dialog and press ok.

Notice the query name and description now appear in the Information panel.

Running a Query in Excel
To run a query, follow these steps:




From the Run menu, select Run Query
Select Next to move past the introduction screen.
Enter appropriate parameter values and press Next



Continue pressing next to run the query until you reach the Select Excel
Parameters screen.
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Select the workbook you require, the starting cell and any sub-total options.
Press Next then Finish to complete the wizard.
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DataPA Enterprise Dashboard
Query Details

Tabs

Ribbon

Toolkit
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Work Area

Status Bar

Data Viewers

Opening a Dashboard
To open the DataPA Enterprise Dashboard, click on the DataPA Enterprise
Dashboard icon from the start menu or on the desktop.
To open a dashboard, follow these steps:



Select Open an Existing Dashboard from the File menu of DataPA Enterprise
Dashboard.
Select the dashboard file you wish to open and press ok.

Refreshing data in a Dashboard
To refresh the data in an open dashboard in the DataPA Enterprise Dashboard, follow
these steps:



Press the left mouse button over the arrow below the Refresh button in the Edit
Dashboard tab of the ribbon.
Select the individual query you wish to refresh, or Refresh All Queries if you
wish to refresh all queries.

Whilst a query is being refreshed, DataPA
Enterprise Dashboard displays an
information box. You can cancel the query
by pressing the cancel button on this
information box.
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DataPA Reports
Toolbars
Menubar

Report Preview
Outlook

Panel

Bar
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Opening a Report
To open the DataPA Report Designer, click on the DataPA Reports icon from the start
menu or on the desktop. To open a report, follow these steps:
 Select Open an Existing Report from the File menu of the report designer.
 Select the report file you wish to open and press ok.

Running a Report
To run an open report in the DataPA Report Designer, follow these steps:
 Select Refresh Data from the Data menu of the report designer.
 Select Next to move past the introduction screen.
 Enter appropriate parameter values and press Next



Press Next to retrieve the data for your report.
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Manipulating Data
Search Text
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Search for data in a report.
The Report Preview panel in the DataPA Reports provide a way for searching for data
within a report.
Method
Search Text

Description
Provides a simple dialog box to search for a text string in the report.

Follow these steps to search:
1. Press the Search Text button to open the search dialog
box.
2. Enter the text you wish to search for.
3. Press Next to find the next instance of the text you are
searching for.

Using the Multiple Page Viewer
The DataPA Reports Preview panel allows you view several pages of the report at
once.
Follow these steps to view multiple pages:
1. Click the Multiple Pages button on the top of the DataPA Reports
Preview panel. The icon for this is
2. Drag the mouse to highlight the number of pages you want to have in
the viewer.
3. Release the mouse and view the report.
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Chapter 3 – Creating Queries
Introduction
DataPA uses queries to define and control data extracts from your business systems.
In this lesson you will learn to create and maintain these queries, and to share them
between different applications.

Learning Objectives
When you complete this lesson you should be able to:





Use the query wizard to create a new query.
Use the query wizard to modify a query.
Create conditions on a query.
Combining more than one subject in a complex query.

Prerequisites
Before you begin this lesson you should be able to:







Access DataPA in Excel and DataPA Reports.
Open a query in Excel.
Open a report in the DataPA Report designer.
Run a query in Excel.
Refresh a report in the DataPA Report designer.
Publish a query to a DataPA Enterprise Service.
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Using the Query Wizard
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Creating a query with the query Wizard
To open the query wizard to create a new query follow these steps:
1. Open DataPA in Excel
2. From the File menu, select Create a New Query
You can create two different types of query, described in the table below:
Query Type
Description
When to use
Standard
Returns a simple listing of the
If you are creating a report,
data set created by the query.
dashboard or query for Excel
where you will want to display the
record level detail of the query
data. For instance, if you were
creating a query on orders, use a
standard query if you will want to
display each order line of the
orders.
Summary
Returns a summarised listing
If you are creating a report,
of the data set created by the
dashboard or query for Excel
query.
where you are only interested in
the data summarised by one or
more columns. For instance, if you
were creating a query on orders,
and you were only interested in the
total value ordered each month.
The following section describes how to create each type of query:
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Follow these steps to create an unfiltered standard query using the query wizard, and
save it to disk:
1. Press Next to step past the introduction screen.
2. Enter a name and description for the query and press Next.
3. Select the subject you wish to create a query from and press Next.

4. Press Next to bypass the Define Filter Conditions Screen.
5. Select the field(s) you wish to be retrieved by the query and press Next.
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6. Select the field(s) you wish to sort the query by and press Next.

7. Press Next to bypass the Add Multiple Subjects to Query screen.
8. Press Finish to create your query.

9. From the File menu select Save Query.
10. Browse to the directory you wish to save your query to and press Save.

Follow these steps to create an unfiltered summary query using the query wizard, and
save it to disk:
1. Press Next to step past the introduction screen.
2. Enter a name and description for the query and press Next.
3. Select the subject you wish to create a query from, select Create a
summary query and press Next.
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4. Press Next to bypass the Define Filter Conditions Screen.
5. Select the field(s) you wish to group by, the fields you wish to
summarise and how you want each summary field to be calculated

6. For each field in the Group by list, select the field and press the Group
Options.
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7. Select the appropriate group options for each group and press OK.

8. Select the field(s) you wish to sort the query by and press Next.

9. Press Finish to create your query.

10. From the File menu select Save Query.
11. Browse to the directory you wish to save your query to and press Save.
19
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Using the Query Wizard
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Modifying a query with the query Wizard
To start the query wizard to modify an existing query follow these steps:
1. Open DataPA in Excel
2. Open the query you wish to modify in DataPA
3. From the Edit menu, select Modify Query
Follow the Query Wizard steps as you would to create a new query to modify your
existing query.
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Creating Fixed Conditions

Logical Operator
Comparison Field
Comparison Type
Condition Type
Fixed Value
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Creating Query Conditions
Conditions allow you to filter the data that is returned by a query. There are two
distinct types of conditions you can add to a query:
Type

Description

Fixed Value

The value for the condition is fixed at the time the query is
created.

Required Value The user will be prompted for a value for the condition each time
they run the query, or a report based on the query.

Creating a Fixed Value Condition
Follow these steps to create a fixed value condition on a query:
1. Open the query in the DataPA Query Wizard and move to the Define
Filter Condition screen.
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2. Press Add to open the query condition builder dialog box.

3.
4.
5.
6.
7.
8.

Select AND as logical operator.
Select the field you wish to create a condition on.
Select Fixed Value as the condition type.
Select the type of comparison you wish to use in your condition.
Enter or select the value you wish to use for your condition.
Press OK to save your condition.

Note, as you select different fields for your condition, the comparison types will
change. If your field is a character, you will be able to select the comparison matches.
This will return any data rows where the field contains the fixed value as all or part of
its value.
If your field is a date, you can also select the options current day and not set as values
for a date. If you select current day this will return all data rows where the field
contains the date at the time the query was run. If you select not set this will return all
data rows where the date has not been set in the business application, i.e. all data rows
where the value of this field is “?”.
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Creating Required Value
Conditions

Logical Operator
Comparison Field
Comparison Type
Condition
Type
Required Value Label
Required Value
Description
Mandatory
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Creating a Required Value Condition
Follow these steps to create a required value condition on a query:
1. Open the query in the DataPA Query Wizard and move to the Define
Filter Condition screen.
Press Add to open the query condition builder dialog box.

2. Select AND as logical operator.
3. Select the field you wish to create a condition on.
4. Select the type of comparison you wish to use in your condition.
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5. Select Required Value as the condition type.

6. Enter a label to be displayed when the user is prompted for a value for
this condition.
7. Enter a description that will be displayed when the user is prompted for
a value for this condition.
8. Select whether or not the condition is mandatory. If you indicate that
this condition is not mandatory, the user can choose to skip the
condition and return all data rows.
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Creating a Condition
For a List of Values

Logical Operator
Comparison Field
Comparison Type
Condition Type
Fixed Value Editor
Add Value Button

Fixed Value List

Delete Value Button
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Creating a Condition For a List of Values
You can also create a condition for a list of values. This actually creates a collection
of conditions grouped together and using the OR logical operator.
Follow these steps to create a condition for a list of values:
1. Open the query in the DataPA Query Wizard and move to the Define
Filter Condition screen.
2. Press Add to open the query condition builder dialog box.

3. Select AND as logical operator.
4. Select the field you wish to create a condition on.
5. Select the type of comparison you wish to use in your condition.
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6. Select List of Values as the type of condition to create.

7. Add values to the Fixed Value List by following these steps:
i. Enter the value in the Fixed Value field.
ii. Press Add to add the value to the list.
8. If you wish to delete any values, follow these steps:
i. Select the value in the Fixed Value List
ii. Press Delete to delete the value from the list.
9. Press OK to create your condition.
Note in the Define Filter Conditions screen, you have now created a collection of
conditions grouped together and separated by the OR logical operator.
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Using Logical Operators and Groups
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Using Logical Operators and Groups
You could also create the list of values we saw in the last example manually using
logical operators and groups. Follow these steps to create the same list of values
manually:
1. Open the query in the DataPA Query Wizard and move to the Define
Filter Condition screen.
2. Create single fixed value condition using the first value of the list of
values and the logical operator “AND”.
3. Create a fixed value condition for each of the subsequent values in the
list using the logical operator “OR”.
4. Select all the new conditions in the Define Filter Condition screen and
press Group.

Using combinations of the logical operators and grouping, you can create sets of filter
conditions for even the most complex requirements.
On some subjects, using conditions with the OR logical operator can cause the query
to run much slower. As a result it is recommended you only use the OR logical
operator where necessary.
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Complex Queries
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Combining more than one subject in a Complex Query
Occasionally, all the fields that you require for a report or query cannot be found in a
single subject. If this is the case, you can combine more than one subject in a single
query to build a complex query. We will also see later on how a complex query can be
used to create sub-reports.
Follow these steps to convert the simple query we created in the previous example
into a complex query:
Open the query in the Query Wizard and move to the Add Multiple Subjects to Query
screen.

Press the Add button to add a subject to the query, this opens the a second copy of the
query wizard dialog box.
Select the subject you wish to add to the query, and press Next.
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In the Define Filter Conditions screen, select Add to add a condition.
In the Query Condition dialog box, ensure the Parent Field option is selected, then
select a field from the parent and child subjects to link the two subjects. Repeat steps
4 and 5 for each pair of fields that link the two subjects.

Add any other conditions to your child query.
Press Next and select any fields you wish to include from the child subject.

Press Next and select any sort fields for the child query.
Press Next and Finish.
The Split Query Results option allows you to return a data set for each subject in the
query, rather than a single combined dataset. We will see later in the course how this
is used in creating sub-reports.
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Publishing a Query
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Publishing a Query
To publish a query, select Publish from the File menu on the toolbar.
Please note that, if security is enabled in your DataPA environment, then you need to
be logged in as a user belonging to a group with the "Members of this group can
publish content" permission item checked before you can access this screen
Note: To be able to publish a query to the DataPA Enterprise Service, a valid Title
and Category must be set within the Query Properties window.
If the query is correctly defined, you will see a publish information box informing you
that the application has published your query.
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Managing Published Content
The Manage Published screen is intended to maintain content which has been
published to the DataPA Enterprise Service.
Please note that, if security is enabled in your DataPA environment, then you need to
be logged in as a user belonging to a group with the "Members of this group can
publish content" permission item checked before you can access this screen.
To manage published content, select Manage Publish from the Setup menu on the
toolbar.
There are currently three types of content that may be published from the various
components of the DataPA product suite to the DataPA Enterprise Service:




Queries from the MS Excel or Access add-ins
Dashboards from the DataPA Dashboard Designer
Reports from the DataPA Report Designer

The Refresh button will query the DataPA Enterprise Service and rebuild the list of
content in case it has been changed.
The Restart Auto Update button is only applicable for dashboards whose queries have
been set to refresh automatically. Selecting this option refreshes the query and sets the
start time in the Refresh Schedule screen to the current time.
The Open button will open the selected content, however this is context sensitive, it
will only be enabled if
 You have a dashboard selected and the screen was launched from the
Dashboard Designer
 You have a query selected and the screen was launched from the Excel /
Access add-in
 You have a report selected and the screen was launched from the Report
Designer.
The Delete button will remove the selected content from the DataPA Enterprise
Service.
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The Up and Down buttons can be used to reorder the content.
If you right click on a dashboard, report or query on this screen when you will have
the option Copy Enterprise URL to Clipboard which will copy the URL you need
to view that content directly in DataPA Enterprise. This is particularly useful if you
are embedding content in a third party web application.
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Chapter 4 – Building Dashboards
Introduction
In this lesson you will learn about the DataPA Enterprise Dashboard application, and
how to use it to create and view dashboards. We will also look at how you can import
existing queries into a dashboard, and share queries from a dashboard to be used
elsewhere.

Learning Objectives
When you complete this lesson you should be able to:












Understand and work with the different components of the DataPA Enterprise
Dashboard interface
Create a new dashboard.
Create, modify and refresh queries in a dashboard.
Understand, work with and create the different objects that make up a
dashboard.
Use and create drill downs within a dashboard.
Apply data filters to objects on a dashboard.
Create and work with treeview filter panels in the dashboard.
Create and work with pivot tables in the dashboard.
Create calculated columns in a dashboard.
Set the properties of a dashboard.
Save, publish and print dashboards.

Prerequisites
Before you begin this lesson you should be able to:
 Open a dashboard in the DataPA Enterprise Dashboard.
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Refresh data in the DataPA Enterprise Dashboard.
Create and save a query in Excel.
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The DataPA Enterprise Dashboard Interface
Query Details

Tabs

Ribbon

Toolkit
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Work Area

Status Bar

Data Viewers

The DataPA Enterprise Dashboard Interface
The DataPA Enterprise dashboard interface comprises a number of key elements that
allow you to view and modify dashboards. The interface includes docking
functionality that allows the size and position of each of these elements to be modified
depending on the type of the element. The different elements are listed below, along
with their type, and the docking functionality is explained thereafter.
Element
Ribbon

Type
Fixed
Object

Work
Area

Fixed
Object

Tabs

Fixed
Object

Query
Details

Docking
Window

Toolkit

Docking
Window

Data
Viewers

Docking
Window

Status Bar

Fixed
Object

Description
The ribbon is the primary interface to access functionality
in the DataPA Enterprise Dashboard. It can be hidden, but
its position cannot be changed from the top edge of the
window.
The Work Area is used to render the currently open
dashboard. It cannot be explicitly moved or resized, but it
will take all the remaining space below the ribbon once the
docking windows and status bar have been rendered.
The tabs represent the different tabs in the open dashboard.
The size and position of the tabs are fixed by the work area,
however you can re-order the tabs by dragging them.
The query details window is a docking window. This means
its size and position can be modified using the docking
interface described below.
The toolkit window is a docking window. This means its
size and position can be modified using the docking
interface described below.
The data viewer windows are docking windows. This
means their size and position can be modified using the
docking interface described below.
The status bar is a fixed information panel at the bottom of
the DataPA Enterprise Dashboard window. It can be shown
or hidden by selecting the Hide the status bar button on the
Application Settings tab of the ribbon.
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Using the Ribbon
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Using the Ribbon
The Ribbon is designed to help you quickly find the commands that you need to
complete a task. Commands are organized in logical groups, which are collected
together under tabs. Each tab relates to a type of activity, such managing queries or
managing tabs.

Minimizing the ribbon
1. Click Customize Quick Access Toolbar .
2. In the list, click Minimize the Ribbon.
3. To use the Ribbon while it is minimized, click the tab you want to use, and
then click the option or command you want to use.
For example, with the Ribbon minimized, you can select an object in your
dashboard, click the Edit Dashboard tab, and then in the DashboardObjects
group, click the edit button. When the Dashboard Object Definition dialog
opens, the ribbon is once again minimized.
As an alternative, you can double click on a tab in the ribbon, check the Minimize
the Ribbon button in the Appearance Group of the Application Settings tab or
press the minimize button
on the right hand side of the ribbon to minimize it.
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Restoring the ribbon
1. Click Customize Quick Access Toolbar
2. In the list, click Minimize the Ribbon.

.

As an alternative, you can double click on a tab in the ribbon, uncheck the
Minimize the Ribbon button in the Appearance Group of the Application Settings
tab or press the maximize button
on the right hand side of the ribbon to restore
it.

The Quick Access Toolbar
The Quick Access Toolbar is a customizable toolbar that contains a set of commands
that are independent of the tab currently displayed. You can move the Quick Access
Toolbar from one of the two possible locations, and you can add buttons that represent
commands to the Quick Access Toolbar.

Configuring the commands on the Quick Access Toolbar
To add or remove commands from the Quick Access Toolbar, follow these steps:
1. Click Customize Quick Access Toolbar at the far top right of the Window.
2. In the list, click the item that represents the command you wish to add or
remove from the Quick Access Toolbar.

Moving the Quick Access Toolbar
The Quick Access Toolbar can be located in one of two places:
Upper left corner, above the Ribbon (default location)

Below the Ribbon

Follow these steps to move the Quick Access Toolbar to the other of the two places:
1. Click Customize Quick Access Toolbar .
2. In the list, click on Show Below the Ribbon or Show Above the Ribbon.
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The Docking Interface
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The Docking Interface
The DataPA Enterprise Dashboard Interface contains two types of objects, fixed
objects and docking windows. You can adjust the viewing and editing space for the
dashboard depending on how you arrange the windows in the Interface. The following
options are just some of the ways windows can be arranged:
1.
2.
3.
4.
5.

Dock docking windows to the edge of a frame in the Interface
Float docking windows over or outside the Interface.
Minimize docking windows along the edge of the Interface.
Hide docking windows altogether.
Reset docking window placement to the default layout.

Docking windows can be arranged by dragging, using commands on the ribbon and
by right clicking the title bar of the window to be arranged.

Floating Windows
Any docking window can be undocked from the Interface and moved anywhere on the
desktop. You can undock a docking window from the Interface in two different ways:
Method 1
1. Press and hold the left mouse button over the title bar of the docked window.
2. Drag the window to a free area of the desktop.
3. Release the left mouse button
Method 2
1. Double click the left mouse button over the title bar of a docked window.

Auto Hiding Windows
Docking windows support a feature called Auto Hide. Auto Hide causes a window to
slide out of the way when you use a different window. When a window is Auto
Hidden, its name is displayed on a tab at the edge of the Interface. To use the window,
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move the mouse over the tab so that it slides into view. By default, any data viewer
windows will be auto-hidden at the bottom of the Interface.
To turn Auto Hide on
1. Press the right mouse button on the title bar of the window you want to hide to
open the context menu.
2. Select Auto Hide.
As an alternative, you can click the pushpin icon on the title bar of the window.
To turn Auto Hide off
1. Press the right mouse button on the title bar of the window you want to hide to
open the context menu.
2. Select Dock.
As an alternative, you can click the pushpin icon on the title bar of the window.

Docking Windows
You can dock any docking window relative to the Interface, Work Area or another
window. The Interface
displays guide icons that
appear when you start
dragging a docking
window.
The guide icon in the
centre of the image on the
right allows you to dock a
window above, to the left,
to the right and below the
work area.
The guide icons around the
edges of the image on the
right allow you to dock a
window on each edge of
the Interface.
When you drag a docking
window over another
docking window, the guide
icon in the centre of the
image on the right appears.
This guide icon allows you
to dock the window above
or below, or to the left or
right of the window. It also
gives the option to stack
the docking windows,
giving a single tabbed
docking window.
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To dock windows in the Interface, follow these steps:
1. Click and hold the left mouse button over the title bar of a non Auto Hidden
docking window.
2. Drag the window until an appropriate guide icon appears, then continue
dragging until the mouse is over the appropriate guide icon.
3. Release the mouse button.

Hiding Docking Windows
If you are short of space on your desktop, you can hide docking windows altogether
and re-establish them when required.
Follow these steps to hide docking windows:
1. Select the Show/Hide button from the Application
Settings tab on the ribbon.
2. Uncheck the menu item that relates to the window
you wish to hide, or press Hide All to hide all
docking windows.
As an alternative, you can press the close icon in the top
right corner or the docking window.
To re-establish a window that has previously been
hidden, follow these steps:
1. Select the Show/Hide button from the Application Settings tab on the ribbon.
2. Check the menu item that relates to the window you wish to hide, or press Show
All to show all docking windows.

Resetting the default docking layout
To reset the default docking layout, follow these steps:
1. Press the Restore Defaults button from the Application Settings tab on the
ribbon.
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Working with Queries in DataPA Enterprise Dashboard

© DataPA

Working with Queries in the DataPA Enterprise Dashboard
Queries define the data that is retrieved from a business application to allow a
dashboard to be rendered. A single dashboard can contain any number of queries.
When refreshed, each query will retrieve one or more datasets from live data in the
business application. The datasets are stored in the dashboard and can be used to build
objects on the dashboard. When you save a dashboard, both the queries and the data
they have retrieved are stored on disk in a single file. When a dashboard is open in the
DataPA Enterprise Dashboard, the queries it contains and any child datasets are listed
in the Query Details docking windows.

Creating queries in DataPA Enterprise Dashboard
When you create a new dashboard, the query wizard (described in detail in lesson 3)
will be shown automatically to allow you to create a first query for the dashboard.
Once you have completed the query wizard the query will be automatically refreshed
to retrieve some data so you can create a dashboard. To add further queries to your
dashboard, follow these steps:
1. Select the New command from the Queries group of the Edit Dashboard tab on
the Ribbon.
2. Complete the query wizard to create the query.
As an alternative, you can press the right mouse button over the Query Details
docking window, then select Create A New Query from the list.

Copying an existing query in DataPA Enterprise Dashboard
Follow these steps to copy an existing query in DataPA Enterprise Dashboard:
1. Select the New command from the Queries group of the Edit
Dashboard tab on the Ribbon.
2. Press Next to bypass the Introduction Screen.
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3. Select Copy an Existing Query.

4. Press Browse and select the query file on disk.
5. Complete the query wizard, making any changes to the query as
required.

Refreshing queries in DataPA Enterprise Dashboard
To refresh queries in the dashboard in the DataPA Enterprise Dashboard, follow these
steps:
1. Press the left mouse button over the arrow below the Refresh button in Queries
group of the Edit Dashboard tab of the ribbon.
2. Select the individual query you wish to refresh, or Refresh All Queries if you
wish to refresh all queries.

Whilst a query is being refreshed, DataPA
Enterprise Dashboard displays an
information box. You can cancel the query
by pressing the cancel button on this
information box.
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Modifying queries in DataPA Enterprise
To modify an existing query in the dashboard, follow these steps:
1. Select the query in the Query Details docking window.
2. Press the Edit command in the Queries group of the Edit Dashboard tab on the
Ribbon.
3. Complete the query wizard.
As an alternative, you can double click on the query on the Query Details docking
window, or select the query in the Query Details docking window, press the right
mouse button and select Edit from the list.

Sharing queries from the dashboard
To share a query from the dashboard, so it can be used in another dashboard, report or
in Excel, follow these steps:
1. Select the query in the Query Details docking window.
2. Press the Share command in the Queries group of the Edit Dashboard tab on
the Ribbon.
As an alternative, you can press the right mouse button on the query in the Query
Details docking window, and select Share from the list.

Showing the last run details for a query in the dashboard
You may wish to see the details of the last run operation of a query, particularly if the
query was refreshed automatically by the server rather than manually in the client. To
view the last run details of a query from the dashboard, follow these steps:
1. Select the query in the Query Details docking window.
2. Press the Show last run details command in the Queries group of the Edit
Dashboard tab on the Ribbon.
3. If the query was refreshed against multiple connections, select the connection
you wish to see the last run details for.

Showing the query string from the dashboard
Occasionally you may have a query in a dashboard that takes longer than expected to
complete, or does not return the data expected. To help understand the behaviour of
the query, you can view the raw query string that is being executed on the server.
(NB. This is only applicable to queries built using a freeform subject). To show the
query string of a query from the dashboard, follow these steps:
4. Select the query in the Query Details docking window.
5. Press the right mouse button.
6. Select Show query string.

Working with data viewers
When a query is successfully refreshed, a data viewer docking window is created as
an Auto Hidden docking window against the bottom edge of the Interface. You can
use this window to view, export and navigate through the data the query has returned.
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Sorting data in the data viewers
To sort data in the data viewers by a particular column, simply click on the header for
that column. To reverse the sort order, simply click on the column header a second
time.

Filtering data in the data viewers
You can apply filters to any number of columns in the data viewer. To apply a filter to
a particular column, follow these steps:
1. Press the filter button in the column header.
2. Select the value in the list you wish to filter by.
You can create more complex filters by selecting Custom from the list.
To remove a filter from a column, follow these steps:
1. Press the filter button in the column header.
2. Select the All in the list.
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Grouping data in the data viewers
You can group data in the data viewer using the values in one or more columns. To
group data in the data viewer, follow these steps:
1. Press the right mouse
button over the data viewer
and select Allow Grouping
from the list.
2. Drag the header of the
column you wish to group
by into the box labelled
Drag a column header here
to group by that column.
You can group by further columns by following these steps:
1. Click on the + symbol for one of the groups in the data viewer so you can see
the column headers in that group.
2. Drag a second column into the group heading section at the top of the data
viewer.
To remove groupings, simply drag the column header from the group heading section
at the top of the data viewer back into the columns section of the data viewer.

Summarising data in the data viewers
To summarise data in the data viewers, follow these steps:
1. Press the right mouse button over the data viewer and select Allow Summary
from the list.
2. From the header of the column you wish to summarise, press the summary
button .
3. Select the type of summary you wish to see, and press OK.
To remove summaries in the data viewer, follow these steps:
1. Press the right mouse button over the data viewer and select Allow Summary
from the list.
2. From the header of the column you wish to summarise, press the summary
button .
3. Uncheck the summaries you wish to remove, and press OK.
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Required Fields in DataPA Enterprise Dashboard
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Required fields in DataPA Enterprise Dashboard
It is often the case that queries will be refreshed automatically and unattended in a
dashboard. As such, the dashboard does not display the Run Query Wizard when a
query is refreshed, as this screen requires user input to complete. This means required
fields in a query must be handled differently.
To resolve this, appropriate user interface elements to prompt for required fields are
added to the dashboard itself as Query Parameters on a control panel. The DataPA
Enterprise Dashboard will add these objects to the dashboard automatically when a
query that has required fields is refreshed for the first time.
If you attempt to refresh a query which has orphaned required fields, that is required
field without an associated Query Parameter object on the dashboard, the DataPA
Enterprise Dashboard will warn you there are missing objects, and ask if you would
like them to be added to your dashboard. If you do not allow these objects to be added
to the dashboard, the query will not refresh.

Removing query parameters from a dashboard
Query parameters are added to objects on the dashboard called Control Panels. When
the DataPA Enterprise Dashboard automatically creates Query Parameters for a query
it first tries to find a control panel on the dashboard that contains at least one query
parameter or query refresh button relating to the current query.
If it cannot find an existing
control panel in this way, it will
create a new one on the currently
selected tab. The query parameter
objects will be added to this
control panel.
You may wish to move the query
parameters to another control
panel. To do this you must
remove, then add them.
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You can remove query parameters in one of two ways, by deleting the control panel
altogether, or by removing the query parameter from the control panel.
To delete the control panel altogether, follow these steps:
1. Click on the control panel in the dashboard.
2. Press the Delete button in the Dashboard Objects group of the Edit Dashboard
tab.
To delete the Query Parameter in the Control Panel, follow these steps:
1. Click on the control panel in the dashboard.
2. Press the Edit button in the Dashboard Objects group of the Edit Dashboard
tab.
3. Click on the Query Parameter in the control panel dialog box to select it.
4. Press the Delete button in the Edit group of the Panel tab in the Ribbon on the
control panel dialog box.
5. Press OK.

Adding a query parameter to a control panel
To add a Query Parameter to a Control Panel, follow these steps:
1. Click on the control panel in the dashboard.
2. Press the Edit button in the Dashboard Objects group of the Edit Dashboard
tab.
3. Press the Query Parameter button from the Add group of the Panel tab in the
Ribbon, then select the query, then the required field you wish to create the
parameter for.
4. Press OK.
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Working with Tabs
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Working with Tabs
A dashboard is a visual display of the most important information that a user needs.
The information is consolidated and arranged on a single screen so that it can be
monitored at a glance.
However, it is not unusual to want a single dashboard to convey a number of different
types of information. As such, a single dashboard can contain several screens,
allowing the user navigating between these screens using tabs.
When you first create a new dashboard, DataPA Enterprise Dashboard creates a single
tab. The Dashboard Tabs group in the Edit Dashboard tab on the Ribbon allows you
to add, remove and change the name tabs in the dashboard. You can re-order tabs by
dragging them.

Adding a new tab to the Dashboard
To add a new tab to your dashboard, follow these steps:
1. Press the New command in the Dashboard Tabs group in the Edit Dashboard
tab of the Ribbon.

Deleting a tab from the dashboard
To delete a tab from the dashboard, follow these steps:
2. Select the tab.
3. Press the Delete command in the Dashboard Tabs group in the Edit
Dashboard tab of the Ribbon.
4. Press Yes in the message box.
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Changing the tab title
To change the title of a tab, follow these steps:
1. Select the tab.
2. Press the Change Tab Title command in the Dashboard Tabs group in the Edit
Dashboard tab of the Ribbon.
3. Enter the new title for the tab
4. Press OK.
As an alternative, you can edit the tab title directly in the tab selection list in the
Dashboard Tabs group of the Edit Dashboard tab in the Ribbon.

Changing the tab order
To change the tab order, follow these steps:
1. Press and hold the left mouse button over the header of the tab you wish to
move.
2. Drag the tab into the position you require.
3. Release the left mouse button.
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Managing dashboard objects
Dashboard objects are the objects that provide the visual display and control elements
of the dashboard. The objects can be grouped into five broad categories, each of
which is described in the following sections.

Data and Control Objects
The Data and Control objects contain data listing and control objects which allow you
to filter the data on the dashboard.
The control panel is a container object for labels, query parameters, filter parameters,
images and refresh buttons. The control panel will be described in detail later in this
lesson.
The tree view selection panel allows the user to apply complex filtering to a
dashboard using a simple tree view interface. The tree view selection panel will be
described in detail later in this lesson.
The pivot table is a tabular representation of data that can automatically sort, count,
total or give the average of data quickly creating unweighted cross tabulations. The
pivot table will be described in detail later in this lesson.
The data grid allows you to display a simple listing of data in a dashboard. It also
gives the user the ability to group, summarise and sort the data. The data grid will be
described in more detail later in this lesson.
Finally, the legend allows you to display a simple listing of data in a dashboard, with
a colour key that can match the colours in a chart. The data grid will be described in
more detail later in this lesson.

Single Series Charts
Single series charts are charts that display data visually by mapping a single set of
textual values (series) against a single numeric value.
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This is either in the form of a circular area chart (pie and doughnut charts), where the
numeric values are represented by the area of segments in the circle, or two
dimensional charts where the numeric values are plotted on a y axis against the textual
values on the x axis.
Use this type of chart when you are interested in the value of a single variable across a
single group. Two examples might be plotting the value of sales by sales
representative, or the value of sales each month this year.

Multi Series Charts
Multi series charts are charts that display data visually by mapping one or more sets of
textual values (series) against one or more numeric values. This is in the form of a two
dimensional chart where the numeric values are plotted on a y axis against the textual
values on the x axis.
Use this type of chart when you are interested in the value of one or more variables
across one or more groups. One example might be plotting the values of sales and the
value discounted by sales representative. Another might be plotting the value of
orders shipped, and the value of orders delivered in each month this year.

Stacked Charts
Stacked charts are a variation on multi-series charts that display data visually by
mapping one or more sets of textual values (series) against one or more numeric
values. This is in the form of a two dimensional chart where the numeric values are
plotted on a y axis against the stacked textual values on the x axis, giving not only an
indication of the individual values for each series, but also an indication of the
summed values across all series.
Use this type of chart when you are interested in the value of one or more variables
across one or more groups, but also wish to see the summed total of the different
values. One example might be plotting the total order value for each month, but
seeing the total order value broken down by the order status.

Combination Charts
Combination charts are a variation of multi-series charts and stacked charts that allow
different types of values to be displayed on a single chart. The different types of
values can be differentiated by giving them a different visual appearance, for instance
displaying them as a column, line or area. In addition, different values that have a
significantly different scale can be plotted on a second Y axis, allowing them to be
scaled independently to fit neatly on to the chart.
A good example of a combination chart might be to plot the value of orders and
quantity ordered each month.

Scroll Charts
Scroll charts are a variation on single series, multi-series, stacked and combination
charts that cater for a large number of series values by scrolling or allowing zooming.
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Gauges
Gauges are objects that show a single value. Gauges are useful when you have a
single value that you want to be measured quickly against a particular range. Some
gauges will allow you to show the value against a number of coloured ranges (such as
a traffic light or dial), and others will allow you to show the value only against a total
range (such as a cylinder or thermometer).
A good example of when a gauge may be useful is to show the total ordered value
against the target, for a specific month or year.

Adding dashboard objects to your Dashboard
You can add dashboard objects to your dashboard in one of two ways, by dragging the
required object from the Toolkit docking window or by selecting the required object
from the Add button of the Dashboard Objects group of the Edit Dashboard tab on
the ribbon. Both these methods are described in more details below.

Adding dashboard objects from the toolkit
Using the toolkit to drag a new object on to the dashboard has the advantage of
allowing you to decide where the new object is placed in the tab, relative to the other
objects already present. To add an object by dragging it from the toolkit, follow these
steps:
1. Press and hold the left mouse button over the appropriate object in the Toolkit
docking window.
2. Move the mouse until it is over the guide icon that represents the location you
want to place the new object (the guide icons are explained in more detail
below).
3. Release the left mouse button.
4. Define the details of the dashboard object in the Dashboard Object Definition
dialog box (explained in more details below).
When you are dragging a new dashboard object on to the chart, the mouse cursor will
change to the chart dragging cursor ( ). As you drag the mouse over the tab, two
types of guide icon will appear.
Guide icons around the edge
of the tab allow you to place
the new dashboard object
against the left, top, right or
bottom edge of the tab.

When you drag the mouse
over an existing object in the
dashboard, guide icons appear
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that allow you to drop the
new object to the left, top,
right, bottom of the existing
object, or stacked on top of
the existing object. If objects
are stacked, tabs will appear
to allow the user to display
each object.
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Adding dashboard objects from the ribbon
Using the Add button of the Dashboard Objects group of the Edit Dashboard tab on
the ribbon to add objects to the dashboard has the advantage of allowing you to select
the object type from an ordered list of objects. To use the ribbon to add a dashboard
object to the dashboard, follow these steps:
1. Press the Add button in the Dashboard Objects group in the Edit Dashboard
tab in the ribbon.
2. Select the type of object you wish to add to your dashboard from the list.
3. Define the details of the dashboard object in the Dashboard Object Definition
dialog box (explained in more details below).

Defining the details of objects in the dashboard
The Dashboard Object Definition window allows you to specify the appearance and
behaviour of dashboard objects that have been added to your dashboard tabs. The
window is opened when you add a new dashboard object to your dashboard, or select
the Edit button in the Dashboard Objects group in the Edit Dashboard tab in the
ribbon. The table below gives an overview of the different tabs in the window, which
will be described in more detail below:
Tab
Data
Appearance

Numeric Format

X Axis

Y Axis

Drill Down
Alerts
Colour
Advanced

Description
Allows you to define the data that will
populate the dashboard object.
Allows you to specify settings that will
govern the appearance of the dashboard
object.
Allows you to specify the numeric
format used to display numbers in the
dashboard object.
Allows you to specify settings that
govern the appearance of the X axis on
the dashboard object.
Allows you to specify settings that
govern the appearance of the Y axis on
the dashboard object.
Allows you to add and define a drill
down to the dashboard object
Allows you to add and define alerts for
this dashboard objects
Allows you to specify the colours used to
render the object
Allows you to add advanced XML
definitions to your dashboard object.
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Defining data for a dashboard object
Follow the steps below to specify the data;
1. First select the Query data set that you wish to base your dashboard object;

2. If you wish to, press the filter button to apply a filter to your data set (applying
filters will be described in more detail below). Next, decide how you want to
group your data, and select the appropriate option;

The three options are
a. On Change of:
Create a record for each distinct combination of the group
values selected.
b. For Each Record:
Creates a record for each record in the source data set,
regardless of the group values selected.
c. For All Records:
Creates a single record regardless of the group values selected.
3. Add the group columns you require (some object types, such as single series
charts, will only allow a single group column).
4. Next, select which summary columns you require (some object types, such as
single series charts, will only allow a single summary column).

5. For each summary column, select the summary operation you wish to be applied.
Distinct count is the number of distinct values in the column for the group
selected.
6. If you want a summary column to be calculated as a percentage, select the
percentage button (%) whilst that column is selected.
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Managing group options
The group options dialog allows you to manage how groups are collated and sorted.
To open the Group Options dialog box, follow these steps:
1. Select the group you want to manage in the Data tab of the object definition
dialog.
2. Press the Group Options button.

Once the Group Options dialog is open, you can change the group you are managing
by selecting the appropriate value in the Group dialog box.

Managing how groups are collated
The Group Selection tab in the Group Options window allows you control how group
values are collated. This can change the number and value of the groups created. If
your group value is a date, or date-time value, you can choose which time interval is
used to create your group. Follow these steps to define data and date-time groups:
Select the time interval you want the group to be created from.

If you selected Quarter, you need to select the month that the first quarter
begins with.
Often, there may be too many group values to fit comfortably on the chart, and you
may only be interested in the groups that have either the largest or smallest values. To
resolve this, you can limit the number of group value using one of the group limiting
options. The table below describes each of these group limiting options:
Group limiting option Description
All
Shows all groups
Top N
Shows a specified number of groups with the highest
summary value.
Bottom N
Shows a specified number of groups with the lowest
summary value.
Top Percentage
Shows groups where a specified summary value is in the
top percentage specified.
Bottom Percentage
Shows groups where a specified summary value is in the
bottom percentage specified.
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To apply one of the group filtering options, follow these steps:
1. Select one of the group limiting option (top n, bottom n, top percentage, bottom
percentage)
2. Select the summary column that will be used as the value to determine the top or
bottom values.
3. Enter a value for the number of groups (N) or percentage.
4. If you want to include all other groups summarised into a single group on the
chart, select Include Others and enter a label for the extra group.
5. If you want to include ties, select the include ties option. For instance, if you
select top N, where N is 5, and the values of group 5 and 6 are identical, the chart
will include 6 groups.

Managing the sort order of Groups
The Group Sorting tab in the Group Options window allows you to define the order in
which the groups are shown in the dashboard object. You can sort each group based
on the group value, or one of the summary values. Follow these steps to define the
sort order:
1. First, select which column the group sorting is going to be based on. This may
be the same column that the group itself is based on, or a summary column.
2. Select how you want the sort column value to be applied to sort the group. The
options are described in the table below:
Option
Description
Ascending
Groups will be sorted in ascending order
using the value of the column selected.
Descending
Groups will be sorted in descending order
using the value of the column selected.
Original Order
Groups will be sorted in the original order
the data is returned by the query.
Specified Order
Groups will be sorted based on an
arbitrary order specified.
3. If you select specified order, you must define the order by selecting each
group value in turn and pressing the add button to add it to the list on the right.
Once you have defined a specified order, you can change the order by dragging the
columns up or down in the list.
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Defining the appearance of your dashboard object
The Dashboard Object Definition window Appearance tab allows you to specify
settings that will govern the appearance of the dashboard object. The options shown
are dependant on the type of dashboard object you are defining. To define the
appearance of a data grid, follow these options:
1. Select DataGrid in the Type list.
2. Select the required grid style (the options are described in the table below).

Option
Data Grid

Legend

Description
The data grid will appear as a standard data grid (identical to the
data viewer dockable windows). This style of data grid allows
the user maximum functionality to apply filters, groupings and
summaries.
The data grid will have an appearance similar to the legend
dashboard object. Although this style does not allow the same
grouping, filtering and summary functionality as the data grid
style, it provides an appearance more in keeping with the other
dashboard objects, whilst maintaining the ability to add
hyperlinks, drill downs and multiple group and summary
columns.

To define the appearance of legends and charts on your dashboard, follow these steps:
1. Select the type of chart or legend you wish to display.
2. Enter a title and second title (the second title will appear on a second line).
3. Select if you want point labels on the chart, whether those labels should (if
possible) be drawn inside the chart, whether they should be shown with vertical
text, whether to show a legend on the chart and whether to use the glass effect
(slightly transparent bars, columns or slices) when rendering the chart.

4. For certain chart types, you can also select whether to display a series as a line,
bar or area, and if the object type has a dual Y axis, which Y axis to display the
series on.
Dual Y Axis charts allow you to
display multiple values with very
different scales on a single chart.
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Defining the numeric format for dashboard objects
The numeric format tab of the dashboard object definition screen allows you to
specify the numeric format of numeric values in a data grid, and the point labels and
(if they have not been defined separately) the labels on the Y axis of your charts.
Follow these steps to define the numeric format for the dashboard object:
1. If you are configuring a dashboard object with a dual Y axis, you can specify a
different numeric format for each Y axis. As such, you need to select which Y
axis you are specifying the details for.

2. If you want to format the numeric values, select the format option.
3. Select the maximum number of decimal places you want to show.
4. Select whether you want to force trailing zero (for instance, the values are
currency and you always want two values after the decimal point).
5. Decide what scaling units to apply to your numeric values in a dashboard object.
Scaling provides notation for large values, so for instance 1340 can be displayed
as 1.34K, and 2345263 can be displayed as 2.35M. There are a number of scaling
units pre-defined for you, however if these do not fit your requirements you can
define your own.

To define your own scaling units, select other from the scaling units list. Next
supply a comer separated list for the scaling units and the scaling values. Each
entry in the scaling units list will be displayed as a suffix to your values. Each
entry in the scaling values represents the amount the value will be divided by
from the previous scaling unit to achieve the display value.
For instance, you could set your scaling units to "Thousands,Millions,Billions"
and your scaling units to "1000,1000,1000". In this example, 1340 will be
displayed as 1.34Thousands, and 2345263 will be displayed as 2.35Millions.
If the scaling units list has one more entry than the scaling values, units will be
given the first entry in the list as a suffix. For instance, for time scaling units, you
could set your scaling units to "minutes,hours,days,weeks,years" and your scaling
values to "60,24,7,52".
6. If required, select a currency symbol (value that will be displayed before your
numeric values). If the value you want is not in the list, select other and enter
your desired value. You can also enter a number suffix, a string that will be
displayed after numeric values.

59

DataPA OpenAnalytics End User Training

Managing the X Axis for dashboard objects
The Dashboard Object Definition window X Axis tab allows you to specify settings
that govern the appearance of the X axis on the dashboard object. Follow the steps
below to specify the X Axis details on your dashboard object;
1. Enter a title for the X Axis.
2. Select the orientation of the labels on the X Axis.

Managing the Y Axis for dashboard objects.
The Dashboard Object Definition window Y Axis tab allows you to specify settings
that govern the appearance of the Y axis on the dashboard object. Follow the steps
below to specify the Y Axis details on your dashboard object;
1. If you are configuring a dashboard object with a dual Y axis, you can specify a
configuration for each Y axis. As such, you need to select which Y axis you are
specifying the details for.

2. Enter a title for your y axis. If you want, you can specify an alternative number of
decimal places for this Y axis, that will override the value specified in the
Numeric Format tab.
3. If all the values to be plotted on a Y Axis are either positive, or all negative, by
default the Y Axis will always have a minimum value (or maximum if all your
values are negative) or zero. If all your values are well above (or well below) zero
if might be sensible to uncheck the "fix minimum value as zero" option so it is
easier to differentiate values plotted against your Y Axis.
Alternatively, you can override that automatic calculation of the Y Axis range, by
selecting that Y Axis values should be fixed, and specifying the minimum and
maximum values. (NB. If the values in your chart cannot be plotted on the range
you have given, the range will be extended to compensate).
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Managing the Colour for dashboard objects.
The Dashboard Object Definition window colour tab allows you to specify the colours
used to render the object. There are two distinct appearances for this tab, if you are
editing a single series line or area chart, and editing any other type of chart.
Follow the steps below to specify the colours for a single series area or line chart;
Press the Line or area colour button and select the desired colour. If you select No
color the chart will use a default colour.

Follow the steps below to specify the colours for all other chart types;
First select the Specify specific colours for each series in this chart check box. Then,
select a series in the series list, and press the Select colour for <series> button. If you
select No color the chart will use a default colour for the selected series.

NB: Series colours are consistent across the whole dashboard. This means any series
with the same name, on an object that also has the Specify specific colours for each
series in this chart option checked will appear the same colour.
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Managing drill downs
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Managing drill downs for your dashboard object
A drill down allows the user to click on an area of a dashboard object, to open another
display that shows more detail. For instance, a user might click on a month in a chart
showing the value ordered each month, to open a chart that shows the top 5 products
ordered in that month. Drill down objects will always be built using the same data set
as their parent objects, but will often display a subset of that data, filtered by the area
of the parent object the user clicked. Follow these steps to define a drill down for a
dashboard object:
If you want the dashboard object to have a drill down, select the enable drill down
checkbox in the Drill Down tab of the Dashboard Object Definition window.
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Next, select which type of drill down you want. The options are described in detail
below;
Type
Drill down shows the summarised
chart data

Drill down shows another chart
showing data relating to the area of
the chart clicked

Drill down shows a gauge showing
data relating to the area of the chart
clicked

Drill down shows a pivot table
showing data relating to the area of
the chart clicked

Source data related to the area of the
chart clicked

Description
The drill down will show a data grid
containing the summarised chart data
as defined in the Data Tab and as
used to render the chart.
The drill down will show another
chart that summarises data filtered to
show only the data relating to the
group represented by the area of the
chart that was clicked
The drill down will show a gauge that
summarises data filtered to show only
the data relating to the group
represented by the area of the chart
that was clicked
The drill down will show a pivot table
that summarises data filtered to show
only the data relating to the group
represented by the area of the chart
that was clicked
The drill down will show a data grid
with the query data selected in the
data tab, filtered to show only the data
relating to the group represented by
the area of the chart that was clicked.

If you select to drill down into another chart, gauge or pivot table, press the Edit Drill
Down button, to open the appropriate window to define the object that will be
displayed.
If you select the Open drill down in
parent frame, the drill down will be
opened in the same panel as the
parent object. If this option is not
checked, the drill down will be
opened in a popup window.
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Adding tree view selection panels
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Adding tree view selection panels
Tree View Selector Panels allow users to quickly apply complex hierarchical filtering
to objects on a dashboard. Follow these steps to add a tree view filter panel to your
dashboard:
1. Drag a tree view panel from the toolkit on to your dashboard, or select Tree
View Selection Panel from the list that appears when you press the Add button
in the Dashboard Objects group of the Edit Dashboard tab.
2. Define the tree view selection panel settings in the Tree View Selection Panel
window (described in more detail below).

Defining data for a tree view selection panel
The Tree View Selection Panel window Data tab allows you to specify the data that
will be used to display and build the filters for your tree view selection panel. Follow
these steps to specify the values that will appear in the tree view:
1. Select the query data set that you wish to base your dashboard object.
2. If you wish to, press the filter button to apply a filter to your data set (applying
filters will be described in more detail below).

3. Select a column in the Available Columns list, and press the Add Column
button to add the column as the root group item.
4. Select a different column as the child filter column in the Available Columns
list, and press the add child column button ( ).
5. Repeat the steps above to add all the columns you require.
6. If you wish to, you can change the way group values are grouped, sorted and
displayed by selecting the group options button to open the group options
window.
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Defining the appearance of a tree view selection panel
The Tree View Selection Panel window Appearance tab allows you to specify settings
that will govern the appearance of the tree view selection panel. Follow the steps
below to specify the appearance of your dashboard object;
1. Enter a title for your tree view selection panel.

Defining which objects a tree view selection panel applies to
The Tree View Selection Panel window Objects to filter tab allows you to specify
which objects on your dashboard the panels filter will be applied to.
The Objects to filter tab contains a root node for all tabs in your dashboard that
contain at least one object that has the same columns as the tree view filter panel.
Each root node contains a child node for each dashboard object in that tab that has the
same columns as the tree view filter panel.
Follow the steps below to apply the filter to objects on the dashboard;
1. Select the node that represents the object.
Alternatively, to select all the objects on a single tab, select node that represents the
tab.
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Adding a Pivot Table
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Adding a Pivot Table
The Pivot Table editor window allows you to specify the appearance and behaviour of
pivot tables that have been added to your dashboard tabs. A pivot table is a tabular
representation of data that can automatically sort, count, total or give the average of
data quickly creating un-weighted cross tabulations.
The Pivot Table editor window consists of the following tabs;
Option
Data
Appearance
Numeric Format

Font
Drill Down
Alerts

Description
Allows you to define the data that will
populate the pivot table.
Allows you to specify settings that will
govern the appearance of the pivot table.
Allows you to specify the numeric format
used to display numbers in the dashboard
object
Allows you to specify the font used to
display data in the pivot table
Allows you to add and define a drill
down for the pivot table
Allows you to define alerts for your pivot
table
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Defining the data for a Pivot Table
Follow the steps below to specify the data;
1. First select the Query data set that you wish to base your dashboard object

If you wish to, press the filter button to apply a filter to your data set. Next,
decide how you want to group your data, and select the appropriate option;
2. Next, add the row and column groupings you require. You can do this by
selecting the appropriate available column and pressing the add button to the
left of the row(s) list or the add button to the left of the column(s) list, or
simply dragging columns from the available columns list to the row(s) list or
column(s) list.

If the value you require is not
directly available from the
columns listed, press the
Calculated Column button to open
the Calculated Column Editor
which allows you to add, modify
or delete calculated columns.
If you wish to, you can change the
way group values are grouped,
sorted and displayed by selecting
the group options button to open
the group options window.
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You can specify an alternative
column label for the row and
column groupings if required. To
specify an alternative label, select
the row or column grouping in the
list, press the right mouse button
and select Use alternative label
from the drop down menu. This
will open the edit label dialog box
to allow you to edit the label.
3. Next, select which summary columns you require.

For each summary column,
select the summary operation
you wish to be applied. Distinct
count is the number of distinct
values in the column for the
group selected.

You can specify an alternative
column label for the summary
column if required. To specify
an alternative label, select the
summary column in the list,
press the right mouse button and
select Use alternative label from
the drop down menu. This will
open the edit label dialog box to
allow you to edit the label.
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The pivot table will
automatically align numeric
columns to the right, and nonnumeric columns to the left. You
can override this behaviour by
selecting the column in the list,
pressing the right mouse button
then selecting either left, right or
centre in the Alignment sub
menu.
Finally, if you want your
summary column to be
displayed as a percentage, select
the percentage button. (

)

Defining the appearance for a Pivot Table
The Pivot Table editor window Appearance tab allows you to specify settings that will
govern the appearance of the pivot table.
The available options are:




Enter a title for the pivot table.
Choose to Show totals
Set the default column width
The default column width can either
be to fit to the contents, or to the
window. This default value can be
overridden by performing a right-click
on the pivot table.
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Defining the Numeric Format for a Pivot Table
The Pivot Table editor window Numeric Format tab allows you to specify settings
that will govern the formatting of numeric information of the pivot table.
You can specify a different numeric format for each summary value in the pivot table.
As such, you need to select which summary you are specifying the details for.

Next, select the maximum number of decimal places you want to show. If your values
are currency values, select force trailing zeros.

Finally, if you require it, select a currency symbol (value that will be displayed before
your numeric values). If the value you want is not in the list, select other and enter
your desired value. You can also enter a number suffix, a string that will be displayed
after numeric values.

Defining the Font for a Pivot Table
The Pivot Table editor window Font tab allows you to specify the Font to use within
the pivot table.
When the checkbox 'Use the font defined below' is checked then the selected font can
be set for the pivot table.
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Defining a Drill down a Pivot Table
The Pivot Table editor window Drill down tab allows you to specify a Drill Down
selection, as described above.
A drill down allows the user to click on a cell in the pivot table, to open another
display that shows more detail. Drill down objects will always be built using the same
data set as their parent objects, but will often display a subset of that data, filtered by
the area of the parent object the user clicked. Follow these steps to define a drill down
for a dashboard object:
First, if you want the Pivot Table to have a drill down, select the enable drill down
checkbox.

Next, select which type of drill down you want. The options are described in detail
below;
Type
Drill down shows the summarised
chart data

Drill down shows another chart
showing data relating to the area of
the chart clicked
Drill down shows a gauge showing
data relating to the area of the chart
clicked
Drill down shows a pivot table
showing data relating to the area of
the chart clicked
Source data related to the area of the
chart clicked

Description
The drill down will show a data grid
containing the summarised chart data as
defined in the Data Tab and as used to
render the pivot table.
The drill down will show a chart that
summarises data filtered to show only the
data relating to the pivot table cell that was
clicked
The drill down will show a gauge that
summarises data filtered to show only the
data relating to the pivot table cell that was
clicked
The drill down will show a pivot table that
summarises data filtered to show only the
data relating to the pivot table cell that was
clicked
The drill down will show a data grid with
the query data selected in the data tab,
filtered to show only the data relating to the
group represented by the pivot table cell that
was clicked.
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If you select to drill down into another chart, gauge or pivot table, press the Edit Drill
Down button, to open the appropriate window to define the object that will be
displayed.

If you select the Open drill down in
parent frame, the drill down will be
opened in the same panel as the
parent object. If this option is not
checked, the drill down will be
opened in a popup window.
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Adding a Gauge
The Gauge Editor window allows you to specify the appearance and behaviour of
gauges that have been added to your dashboard tabs.

The editor window consists of the following windows;
Tab
Description
Data
Allows you to define the data that will populate the gauge.
Appearance
Allows you to specify settings that will govern the appearance
of the gauge.
Numeric Format
Allows you to specify the numeric format used to display
numbers on the gauge.
Colour
Allows you to specify colours for the gauge
Drill Down
Allows you to add and define a drill down to the gauge
Alerts
Allows you to define alerts for the gauge
Advanced
Allows you to add advanced XML definitions to your gauge.

Specifying Data for your Gauge
The Gauge Definition window Data tab allows you to specify the data that will be
used to render your gauge.
Follow the steps below to specify the data;
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First select the Query data set that you wish to base your dashboard object;

If you wish to, press the filter button to apply a filter to your data set. If the values you
require for your gauge are not directly available from the columns listed, press the
Calculated Column button to open the Calculated Column Editor which allows you to
add, modify or delete calculated columns.
Next, you need to define the value that the gauge will display. First, select the column
that represents the value that will be displayed. Next select the summary operation
that will be used to calculate the value for the gauge. Finally, if you want the values
on the gauge to be displayed as a percentage, select the percentage button. ( )

If the gauge object you are defining supports colour ranges, you can choose to allow
the minimum and maximum values for each colour range to be calculated
automatically, or set manually. If you opt to allow the colour ranges to be
automatically calculated, each colour range will represent exactly a third of the range
for the whole gauge.
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To define the range for the whole gauge (the minimum and maximum values that will
be displayed on the range), first select the Range for the whole gauge option in the list
of ranges.

Next we need to define a value for the minimum and maximum values. The value can
be a fixed value, or a dynamic value derived from one of the columns in the data set.
To set a range value to a fixed value, select Fixed Value, then enter the value.
To set a range value to be dynamic, select the column, then the summary type that
will be used to calculate the range value.
Just be aware, if the value the gauge displays is smaller than the minimum value you
have defined, or larger than the maximum value you have defined the range will be
automatically extended to allow the value to be represented on the gauge.
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Next, if the gauge object we are defining supports colour ranges, we can choose
whether to show each colour range and define how it will appear.

To show or hide a particular colour range, select the colour range in the list of ranges
and check or uncheck the Show this range option.
The minimum and maximum values for a colour range can be a fixed value, or a
dynamic value based on a percentage of the whole gauge range, or a summary
calculation on a column in the data set.
To set a colour range value to a fixed value, select Fixed Value, then enter the value.
To set a range value to be dynamic based on a percentage of the whole gauge range,
select Percentage of Range, then enter the percentage value.
To set a range value to be dynamic based on a column, select the column, then the
summary type that will be used to calculate the range value.
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Finally, select a colour for the colour range.

If you are defining a Traffic Light gauge object, you can enter a label for each of the
colour ranges. You can choose the display these labels rather than the value on the
gauge.

Defining the Appearance of the Gauge
The Gauge Editor window Appearance tab allows you to specify the appearance of
the gauge. Follow the steps below to specify the appearance of your gauge;
First, select the type of gauge object you wish to display, enter a title and select
whether or not you wish the value represented by the gauge to be added as a label to
the gauge.

Next, if your gauge object supports labels, choose whether you want the labels for the
gauge shown inside the gauge, outside the gauge or not shown at all.

If your gauge object supports tick marks choose whether tick marks should be shown
inside the gauge, outside the gauge or not at all.
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If your gauge object supports tick marks choose whether tick marks should be shown
inside the gauge, outside the gauge or not at all. Next enter the number of major and
minor tick marks, and the frequency of labels on the gauge.

If you are defining a Traffic Light gauge you can choose to display range labels rather
than the value on the gauge. You can also select whether to show the label or value
below the gauge, inside the gauge or not at all.

Defining Numeric Formats for a Gauge object
The Gauge Editor window Numeric Format tab allows you to specify the numeric
format used to display numbers in on the gauge. Follow the steps below to specify the
numeric format on your gauge;
First, select the maximum number of decimal places you want to show. If your values
are currency values, select force trailing zeros.

You can apply scaling to your numeric values in a gauge. Scaling provides notation
for large values, so for instance 1340 can be displayed as 1.34K, and 2345263 can be
displayed as 2.35M. There are a number of scaling units pre-defined for you, however
if these do not fit your requirements you can define your own.
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To define your own scaling units, select other from the scaling units list. Next supply
a comer separated list for the scaling units and the scaling values. Each entry in the
scaling units list will be displayed as a suffix to your values. Each entry in the scaling
values represents the amount the value will be divided by from the previous scaling
unit to achieve the display value.
For instance, you could set your scaling units to "Thousands,Millions,Billions" and
your scaling units to "1000,1000,1000". In this example, 1340 will be displayed as
1.34Thousands, and 2345263 will be displayed as 2.35Millions.
If the scaling units list has one more entry than the scaling values, units will be given
the first entry in the list as a suffix. For instance, for time scaling units, you could set
your scaling units to "minutes,hours,days,weeks,years" and your scaling values to
"60,24,7,52".
If you require it select a currency symbol (value that will be displayed before your
numeric values). If the value you want is not in the list, select other and enter your
desired value. You can also enter a number suffix, a string that will be displayed after
numeric values.

Finally, if you wish to suppress the thousand separator for numbers, select the
Suppress thousand separator check box.

Selecting Colours for your Gauge
If your gauge supports colour ranges the screen allows you to change the colour for
each colour range.
To define colours for the colour ranges, select the colour range then press the button
to choose the colour for this range.
If your gauge does not support colour ranges, simply select the colour to be used
when rendering your gauge.
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Defining Drill Downs for a Gauge
A drill down allows the user to click on your gauge, to open another display that
shows more detail. For instance, a user might click on a gauge showing sales against
forecast, to open a chart showing sales by sales rep. Drill down objects will always be
built using the same data set as their parent objects. Unlike charts and pivot tables, the
data will not be filtered on drill down from a gauge, as the gauge does not define any
groups or series. Follow these steps to define a drill down for a gauge:
If you want the gauge to have a drill down, select the enable drill down checkbox in
the Drill Down tab of the Gauge Definition window.
Select the type of drill down you wish to define. The types are described below:

Type
Drill down shows the summarised
chart data

Drill down shows another chart
showing data relating to the area of
the chart clicked
Drill down shows a gauge showing
data relating to the area of the chart
clicked
Drill down shows a pivot table
showing data relating to the area of
the chart clicked
Source data related to the area of the
chart clicked
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Description
The drill down will show a data grid
containing the summarised gauge data
as defined in the Data Tab and as
used to render the gauge.
The drill down will show a chart that
summarises gauge data
The drill down will show a gauge that
summarises gauge data
The drill down will show a pivot table
that summarises gauge data
The drill down will show a data grid
with the query data selected in the
data tab, filtered to show only the data
relating to the gauge.
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If you select to drill down into another chart, gauge or pivot table, press the Edit Drill
Down button, to open the appropriate window to define the object that will be
displayed.
If you select the Open drill down in
parent frame, the drill down will be
opened in the same panel as the
parent object. If this option is not
checked, the drill down will be
opened in a popup window.
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Managing control panels
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Managing control panels
We have already been introduced to control panels when we discussed how they were
added to the dashboard to provide an input control for query parameters earlier in this
lesson. You can also add your own control panels to a dashboard to provide titles,
images, filter parameters, query parameters and query refresh buttons.

Adding a control panel to a dashboard
Follow these steps to add a control panel to your dashboard:
1. Drag a control panel from the toolkit on to your dashboard, or select Control
panel from the list that appears when you press the Add button in the
Dashboard Objects group of the Edit Dashboard tab.
2. Define the control panel selection panel settings in the Control Panel window
(described in more detail below).

Deleting a control panel from a dashboard
To delete the control panel from a dashboard, follow these steps:
1. Click on the control panel in the dashboard.
2. Press the Delete button in the Dashboard Objects group of the Edit Dashboard
tab.
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Managing control panel objects
Each control panel contains one or many control panel objects. The Control Panel
window allows you to manage these objects on a particular control panel.

The Control Panel window has a ribbon
at the top of the window, and a work area
at the bottom of the window.

The ribbon has two tabs, the Panel tab
that contains buttons to add, delete and
move control panel objects in the control
panel. The Objects tab allows you to edit
properties of a single control panel object
in the control panel.

The work area displays the control panel you are currently working on, and allows
you to select a single control panel object on the control panel. To select a control
panel object on the control panel, simply press the left mouse button over the control
panel object. The selected control panel object is highlighted in the work area.
The different control panel objects that you can add to a control panel are described in
the table below:
Object Type
Title
Query Parameter
Filter Parameter
Image
Refresh Query Button

Description
Allows you to add a text title to your control panel object.
Provides values for query required fields, allowing data to
be filtered on the server when the query is refreshed.
Provides an object to input a filter value that can be used
to filter objects on the dashboard.
Allows you to add an image to the control panel.
Provides a button to refresh a query and draw the live
information from the server.
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Adding a title to a control panel object
Titles allow you to add a text title to your control panel object. To add a title to your
control panel object follow these steps:
1. Press the Title button in the Add group of the Panel tab.
2. Enter the text you want to appear as your title in the Label dialog box and
press OK.
3. Modify the font and font appearance using the Label group of the Objects tab.

Adding query parameters to the control panel
We have already seen how Query Parameters provide values for query required fields,
allowing data to be filtered on the server when the query is refreshed. Query
parameters are automatically added to a control panel when you create a query that
has required fields. However, you may want to add the query parameters to an
additional or different control panel. To add a Query Parameter to a Control Panel,
follow these steps:
1. Press the Query Parameter button from the Add group of the Panel tab in the
Ribbon, then select the query, then the required field you wish to create the
parameter for.
2. Press OK.

Adding filter parameters to the control panel
Filter parameters provide an object to input a filter value that can be used to filter
objects on the dashboard. Applying the filter to objects on a dashboard is described in
detail in the Applying Filters to Objects section below. The different types of filter
objects you can add to a control panel are described in the table below:
Type
Drop down list
Date Picker
Slider
Check Box

Description
Allows the user to select a value from a pre-defined list of values.
Allows the user to select a date value.
A slider control allows the user to select a numeric value between
a predefined minimum and maximum.
Allows a user to select a true or false value.

Follow these steps to add a filter parameter to the control panel:
1. Press the Filter Parameter button in the Add group from the Panel tab.
2. Select the type of object from the drop down list.
3. Define the details of the object using the Object tab (described in more detail
below).
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Defining the details of a drop down list
To define the details of a drop down list filter parameter, follow these steps:
1. Press the Edit Text button of the Label group in the Objects tab, enter the text
for the drop down list label and press OK.
2. Modify the font and font appearance using the Label group of the Objects tab.
3. Press the Drop Down Contents button in the Behaviour group of the Objects
tab.
4. Define the drop down list contents (described in more detail below) and press
OK.
You can define the contents of the drop down list using data returned from a query, or
manually. Both methods are described below.
To define the contents of the drop down list using data returned from a query,
follow these steps:
1. Select the option to populate the drop down list from a query, then select the
query data set you want the values to be drawn from.
2. If you want to filter the query data set (perhaps to filter the contents based on
another filter parameter), select the filter button to open the Define Filter
Condition window to allow you to define the filter.

3. Select the column you want to use to build a list of values to be displayed in
the drop down list.
4. If the column is a date field, select which time interval you want to be used to
build the display values.
5. You may wish to use a value from column other than the display column in
your filter condition. To define a different column as the filter parameter
value, select the use a different column check box and select the column you
want to use.

6. Finally, select whether you want the values sorted (by the display value, rather
than shown in the original order), whether you want to ignore duplicate items,
and whether you want to include an option for all (if all is selected any filter
condition based on this filter parameter will be ignored).
(NB. if you have opted to use different columns for the display and value
columns, two items are only considered duplicate if both columns have the
same value).
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To define the contents of a drop down list manually, follow these steps:
1. Select the manual option, then
repeatedly enter an item and press
Add to add it to the list.
2. To change the order of values in
the list, select the value, then
press the green up or down arrows
to move its position in the list.
3. To delete an item from the list,
select it in the list then press the
Delete key.
4. When all items are in the list,
press OK.

Defining the details of a date picker
Follow these steps to define the details of a date picker:
1. Press the Edit Text button of the Label group in the Objects tab, enter the text
for the date picker label and press OK.
2. Modify the font and font appearance using the Label group of the Objects tab.

Defining the details of a slider
Follow these steps to define the details of a slider:
1. Press the Edit Text button of the Label group in the Objects tab, enter the text
for the slider label and press OK.
2. Modify the font and font appearance using the Label group of the Objects tab.
3. Press the Slider Scale button in the Behaviour group of the Objects tab.
4. Define the slider scale (described in more detail below).
5. Define the numeric format (described in more details below) and press OK.
There are two ways you can define the slider scale, using data returned from a query
of manually entering the values. Both of these methods are described in details below.
To define the scale of the slider using data returned from a query, follow these
steps:
1. Select the set range of the slider
from the minimum and maximum
values of a column returned by a
query check box.
2. Select the query data set, and the
column you wish to use to
calculate the range.
3. Finally, select whether the slider
should show labels and major and
minor tick marks.
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To define the scale of the slider manually, follow these steps:
1. Select the set range of the slider manually check box.
2. Enter a minimum and maximum value for the scale.
3. Finally, select whether the slider should show labels and major and minor tick
marks.

To define the numeric format for a slider, follow these steps:
1. Select the Numeric Format tab of the Slider Properties window.
2. Select the maximum number of decimal places you want to show.
3. Select whether you want to force trailing zero (for instance, the values are
currency and you always want two values after the decimal point).
4. Decide what scaling units to apply to your numeric values on the slider.
Scaling provides notation for large values, so for instance 1340 can be
displayed as 1.34K, and 2345263 can be displayed as 2.35M. There are a
number of scaling units pre-defined for you, however if these do not fit your
requirements you can define your own.

To define your own scaling units, select other from the scaling units list. Next
supply a comer separated list for the scaling units and the scaling values.
5. If required, select a currency symbol (value that will be displayed before your
numeric values). If the value you want is not in the list, select other and enter
your desired value. You can also enter a number suffix, a string that will be
displayed after numeric values.

Defining the details of a check box
Follow these steps to define the details of a check box:
1. Press the Edit Text button of the Label group in the Objects tab, enter the text
for the check box label and press OK.
2. Modify the font and font appearance using the Label group of the Objects tab.
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Moving control panel objects on a control panel
To move a control panel item up or down in the control panel, follow these steps:
1. Select the control panel object in the work area of the Control Panel window.
2. Press the Move Up or Move Down button in the Edit group of the Panel tab in
the ribbon.

Deleting control panel objects
To remove a control panel object from a control panel, follow these steps:
1. Select the control panel object in the work area of the Control Panel window.
2. Press the Delete button in the Edit group of the Panel tab in the ribbon.

Previewing a control panel
The Preview button in the Appearance group of the Panel tab removes the selection
highlight from the selected control panel object in the work area. This means the
control panel in the work area appears exactly as it will in the dashboard.

Changing the background colour of the control panel
Follow these steps to change the background colour of the control panel
1. Press the Background Colour button in the Appearance group of the Panel tab.
2. Select the colour.
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Applying filters to objects
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Applying filters to objects
Wherever you can select a query data set to apply to an object on the dashboard, you
can also apply a filter by pressing the data filter button ( ). Filters can be static, for
instance if you want to create a chart that shows orders for a specific country, or
linked to a filter parameter or tree view panel, in which case the user can change the
filter dynamically by changing the selection in objects on the dashboard.
There are three ways you can define a filter for an object on the dashboard, by using
the filter builder, by assigning a tree view selection panel or manually editing the
filter. Each of the three methods is described in detail below.

Using the filter builder
To define a filter using the filter builder, follow these steps:
1. Select the Filter Builder tab.
2. Press Add to open the define filter condition window and create a new
condition (described in more detail below).
3. Repeatedly add conditions until your filter is complete
4. To group conditions, select multiple conditions and press the Group button.

5. Press OK to finish.
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The Define Filter Condition window allows you to define three types of condition, a
simple fixed value condition, a list of fixed values condition or a filter parameter
condition. Each is described in more detail below.
To define a simple fixed value condition, follow these steps:
1. Select the column you want to apply the condition to.
2. Select the operator to use to compare the column.
3. Select or enter the value to compare the column to.

NB. The list of values offered in the drop down list will include all the values
available in the current dataset, and two additional values, the user name and
the user group. These two values allow you to create dashboards that are
filtered based on the user, or group that the user belongs to. To use these
values, your data will need to contain a column that includes the user name or
user group to be filtered against. This column can be a calculated column,
generating these values from other columns. See Knowledge Base article 123
for more details.
To define a list of fixed values condition, follow these steps:
1.
2.
3.
4.

Select the column you want to apply the condition to.
Select the operator to use to compare the column.
Press the list button
Repeatedly select or enter a value and press Add to add it to the list.

To define a filter parameter condition, follow these steps:
1. Select the column you want to apply the condition to.
2. Select the operator to use to compare the column
3. Press the filter parameter button ( ).
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4. Select the filter parameter you want to use.

NB. If you create a condition that is linked to a filter parameter, and the filter
parameter object is deleted from the dashboard, the condition is changed to be a fixed
value condition with the fixed value being the last known value of the filter parameter.
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Applying a tree view filter panel filter
As we described earlier in this lesson, tree view filters can be applied to objects from
the Tree View Filter Panel Editor window. We can also apply tree view filters to
objects from the Define the data Filter window. If an appropriate tree view filter panel
(one for which all the columns in the tree view are represented in the objects data set)
exists, the Tree View Selection Panel tab will be offered in the Define the data Filter
window. Follow these steps to apply a tree view filter to an object:
1. Selection Panel tab.
2. Check the Use a tree view selection panel to filter this object check box.
3. Select the tree view selection panel you wish to use.

Manually entering a filter
Filters are applied to the data using the Microsoft ADO.NET RowFilter property.
Follow these steps to manually enter a filter for your objects:
1. Select the Manually edit the filter tab.
2. Select the Edit the filter manually checkbox.
3. Enter the required filter string and press OK to confirm.
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Defining alerts for a dashboard
Alerts allow you to notify stakeholders when a particular event occurs. For instance, if
demand in a production environment exceeds a certain threshold, you may want to
notify a shift manager so he can make sure enough staff are available. Alerts can be
added to most objects on a dashboard (details of which are described below). The user
can be notified when an alert is triggered in a number of different ways;
Alerts will be highlighted by the alert icon, and can be opened from the alert menu
when the dashboard is opened (in the client application or web) and the alert
conditions resolve to true.

If the dashboard is set to refresh automatically on the server, an alert can be sent by
email when the dashboard refreshes and the resulting data causes the alert conditions
to resolve to true. Similarly, if the dashboard is set to refresh automatically on the
server, a message can be tweeted when the dashboard refreshes and the resulting data
causes the alert conditions to resolve to true. Finally, if the dashboard is set to refresh
automatically on the server, a notification will be raised on any mobile or wearable
device with access to that dashboard through the relevant DataPA app when the
dashboard refreshes and the resulting data causes the alert conditions to resolve to
true.
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Adding alerts to a dashboard object
The object definition, pivot table and gauge windows all include an alert tab that
allow you to manage alerts for that particular object.
Alerts defined for that specific
object will be listed on this tab.
A green tick next to the alert
indicates the alert currently
resolves to true.
To add an alert, press the add
button. To edit or delete the
alert, select the alert in the list,
then press the edit or delete
button.

Adding or editing an alert, will open the alerts window, which contains 3 tabs;
Tab
Details
Email
Twitter

Description
Allows you to define the alert details (text and conditions).
Allows you to specify whether the alert will trigger an email when raised
on the server.
Allows you to specify whether the alert will trigger a tweet when raised
on the server.

Defining Alert Details
Follow the steps below to define the details for your alert;

First, enter the text that will appear in titles and notifications for this alert. Next, you
may wish to ensure the alert is not raised too often. For instance, if a dashboard was
scheduled to refresh automatically every minute and the alert conditions remained
true, the alert would send notifications, (and tweets and emails if so configured) every
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minute. To prevent this without reducing the refresh interval of the dashboard, you
can set a minimum time interval before which a repeat alert will be raised.
Next you need to define the conditions that will determine when this alert is raised. To
add a condition, press the Add button and select the series values, group values,
operator and value as appropriate. The alert condition screen looks at the summary
data defined by your dashboard object. As such its appearance and options change
significantly depending on the parent object, however they will be fairly intuitive.

You can add multiple conditions to an alert, linking them with logical Ands and Ors to
build the appropriate expression.

Adding and email to an alert
The Alerts window Email tab allows you to specify whether the alert will trigger an
email when raised on the server, and if so, the details of that email. If a dashboard is
scheduled to refresh automatically and you would like an email sent if the new data
results in the alert conditions resolving to true, follow the steps below;
First ensure the checkbox labelled Send an email when this alert is raised is checked,
then enter the email address or addresses you want the email to be sent to. Add the
text you want in the body of the email, and finally choose whether to include an image
of the chart by selecting whether or not the checkbox labelled Attach an image of the
object to the email is checked.

For emails to be delivered, the server needs to be correctly configured to use an
appropriate SMTP server to send the emails on your behalf. If you are a member of a
group that has permission to manage the server you can configure the server so it has
access to your mail server by pressing the Server Settings button (details on how to
configure the server are covered in the DataPA Administration Course).
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Posting to Twitter with Alerts
The Alerts window Twitter tab allows you to specify whether the alert will trigger a
tweet when raised on the server, and if so, the details of that tweet. If a dashboard is
scheduled to refresh automatically and you would like a tweet sent if the new data
results in the alert conditions resolving to true, follow the steps below;
First ensure the checkbox next to each Twitter account you want the tweet to appear
on is checked (see below for details on adding Twitter accounts), then enter the text
for the tweet. Choose whether to include an image of the chart by selecting whether or
not the checkbox labelled Include image with tweet is checked, and finally choose
whether to add a link to the dashboard to the tweet by selecting whether the checkbox
labelled Include link to dashboard with tweet is checked.

If you are a member of a group that has
permission to manage the server you can
add, edit and remove Twitter accounts by
pressing the button to the top left of the
list of Twitter accounts.
Details of managing twitter accounts and
groups are covered in the DataPA
Administration course.
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Editing dashboard objects
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Editing dashboard objects
To edit a dashboard object in your dashboard, follow these steps:
1. Select the dashboard object you want to edit in the tab.
2. Press the Edit button in the Dashboard Objects group in the Edit Dashboard
tab.
3. Complete the required changes in the Dashboard Object Definition window.

Moving dashboard objects
You can move dashboard objects either within the tab they are currently displayed, or
between the tabs in a dashboard.
To move dashboard objects within a tab, follow these steps:
1. Select that tab that contains the object you want to move.
2. Press the Design Dashboard Tab button in the Dashboard Tab in the Edit
Dashboard tab.
3. Press and hold the tab header of the dashboard object you want to move.
4. Drag the object over the appropriate drag icon (described in detail below).
5. Release the left mouse button.
6. Press the Preview Dashboard Tab button in the Dashboard Tab in the Edit
Dashboard tab.
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As you drag the object over the tab, two types of guide icon will appear.

Guide icons around the edge of
the tab allow you to place the
dashboard object against the left,
top, right or bottom edge of the
tab.

When you drag the mouse over
an existing object in the
dashboard, guide icons appear
that allow you to drop the object
to the left, top, right, bottom of
the other object, or stacked on
top of the other object. If objects
are stacked, tabs will appear to
allow the user to display each
object.

To move a dashboard object from one tab to another, follow these steps:
1. Select the dashboard object in the tab.
2. Press the Cut button in the Dashboard Objects group in the Edit Dashboard
tab.
3. Select the tab you want to move the dashboard object to.
4. Press the Paste but button in the Dashboard Objects group in the Edit
Dashboard tab.
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Using calculated columns
Calculated columns allow you to add your own columns to the data sets returned by a
query, and use those columns in your dashboard. The Calculated Column Editor
allows you to Add, Modify and Delete calculated columns to your available data sets.
To open the Calculated Column Editor press the Calculated Columns button in the
Queries group of the Edit Dashboard tab on the ribbon.
The Calculated Column Editor consists
of three panels, the Calculated Columns
Treeview, the Expression Text Box and
the Expression Elements Treeview.

The Calculated Column Treeview displays the available queries, data sets and
calculated columns. Each icon in the treeview are described below:
The Query icon indicates a query. To add a Calculated Column to the root
dataset of the query, select the query then press the add calculated column
button ( ).
The data set icon indicates a child data set of a multi level query where split
results has been selected to indicate you want the query to produce multiple
data sets. To add a calculated column to the dataset, select the dataset then
press the add calculated column button ( )
The Calculated column buttons indicates a calculated column. To modify the
name or data type of the calculated column, select the calculated column then
press the edit calculated column button ( ). To change the calculated columns
expression, select the calculated column, then edit the expression using the
expression text box. To delete the calculated column, select the calculated
column then press the delete calculated column button ( ).
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To create a new calculated column, follow these steps:
1. Select the query or data set you would like to add the calculated column to in
the Calculated Columns Treeview.
2. Press the the add calculated column button ( ).
3. Enter the name of the calculated column you wish to create.
4. Select the type for the calculated column you wish to create.
5. Enter the expression for your calculated column (described in more detail
below).
6. Press OK.
Writing calculated column expressions
The expression text box is a free text editor that allows you to enter the expression for
the calculated column. You can also use the Expression Elements Treeview to add
pre-defined text to your expression.
The expression is calculated using the .NET
DataColumn Expression property. For details on
the syntax of the expression, lookup
DataColumn.Expression at msdn.microsoft.com.
Each time you make a change to the expression,
the syntax of the expression is checked, and the
results displayed in the syntax message below the
expression text box.
If the syntax of the expression
you have entered is incorrect,
the Calculated Columns
Treeview and OK button will be
disabled and the details of the
syntax error will be displayed in
the syntax message below the
expression text box.
You cannot exit the Calculated
Column Editor until you have
entered a valid expression for
the selected calculated column.
You can do this by either changing the text to a correct expression, or press the undo
button ( ) to revert to the last correct expression.
The Expression Elements Treeview provides access to a wide range of expression
elements, described below, that you can add to your expression. To add an element
from the expression elements treeview to your expression, press the + symbol on the
element category to expand the category, then click on the element you want to add to
your expression. The current selected text in the expression text box will be replaced
with the text of the expression element you have selected.
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The Available Columns expression elements
allow you to add existing columns returned by
the query to your expression.

The Calculated Columns expression elements
allow you to add other calculated columns that
you have already defined for this query or
dataset to the expression.

The Operators expression elements allow you
to add operators to your expression. For
details on the behaviour of each operator,
lookup DataColumn.Expression at
msdn.microsoft.com.

The Operators expression elements allow you
to add aggregates to your expression. For
details on the behaviour of each aggregate,
lookup DataColumn.Expression at
msdn.microsoft.com.
Beware of defining calculated columns that
use aggregates on large datasets as they can
cause your dashboard to be slow to render.

The Functions expression elements allow you
to add functions to your expression. For
details on the behaviour of each function,
lookup DataColumn.Expression at
msdn.microsoft.com.
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Managing dashboard properties
The dashboard properties allow you to define the identity, refresh schedule, how
connections are managed and how data is managed for a dashboard. The dashboard
properties screen is opened in the following ways
1. Select Properties from the File menu on the ribbon, then select the Refresh
Schedule Tab, or
2. Press the Manage Schedule, Manage Connections or DataManagement
buttons in the Queries group of the Edit Dashboard tab on the ribbon.

Managing the identity of your dashboard
The identity of the dashboard can be used to provide descriptive elements for your
dashboard that aid in identifying and search for it in DataPA Enterprise. Follow these
steps to define the identity of your dashboard:
1. Select Properties from the File menu on the ribbon, then select the Dashboard
Identity Tab or press the Manage Schedule button in the Queries group of the
Edit Dashboard tab on the ribbon.
2. Enter a Title for your dashboard.
3. Enter a Description for your dashboard.
4. Enter a comer separated list of keywords for your dashboard.
5. Enter a Category for your dashboard.
6. Enter any comments you wish to be assigned to your dashboard.
7. Enter the Author of your dashboard.
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Managing the refresh schedule of your dashboard
Defining a refresh schedule for your dashboard allows you to control if, and when the
queries in your dashboard are automatically refreshed. You can set the refresh
schedule for all queries in your dashboard, or each query individually.
To define a refresh schedule for all queries in your dashboard, follow these steps:
1. Select Properties from the File menu on the
ribbon or press the Manage Schedule button
in the Queries group of the Edit Dashboard
tab on the ribbon.
2. Select the Refresh Schedule tab.
3. Select All Queries in the tree view.
4. Define the refresh schedule options
(described below).
NB. If the screen does not allow you to define all the refresh schedule settings for all
queries, it is because some queries have unique settings defined. To enable all the
settings for all queries, make sure all queries have the same settings. You can do this
quickly by pressing the Reset Defaults button.
To define a refresh schedule for a single query, follow these steps:
1. Select Properties from the File menu on the
ribbon or press the Manage Schedule button
in the Queries group of the Edit Dashboard
tab on the ribbon.
2. Select the Refresh Schedule tab.
3. Select the query you wish to edit in the tree
view.
4. Define the refresh schedule options
(described below).
To define the schedule options, follow these steps:
1. If you want the query to be automatically refreshed when you open the
dashboard, select the Refresh query when dashboard is opened option.
2. If you want the query to be periodically refreshed, select the Automatically
refresh the query every option, and set the time interval.

If you set the refresh interval for a particular query to a short period, and the period
expires while the particular, or another query is refreshing, the query is queued for
refresh at the next possible interval.
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The last refresh time is stored within the query. This means if you save and close a
dashboard, then re-open it, the refresh interval will be calculated from the last time the
query was refreshed.
If you cancel a query refresh, or the refresh fails, the query will not be automatically
refreshed until the query is either manually refreshed successfully or you re-open the
dashboard.
To reset the default settings for all queries, press
the Reset Defaults button. This will set the refresh
on open and auto refresh options to false, and the
time interval to 5 minutes for all queries.

Managing Connections
The Dashboard Properties Connections Tab allows you to define whether your query
will refresh against the default connection, a specified alternative connection or
against multiple connections. This last option, to refresh a query against multiple
connections, allows users to construct dashboards that collate data across multiple
installations of an application. A column is automatically added to the query results
containing the connection name.

Refresh the selected queries against the default connection.
Selecting this option, which is the default, causes the selected queries to refresh
against the default connection for the system.
Refresh the selected queries against the connection selected below.
Selecting this option, enables the list of available connections for the system used by
the query, in single select mode. You can then select which connection the query
should refresh against.
Refresh the selected queries against multiple connections selected below.
Selecting this option, enables the list of available connections for the system used by
the query, in multi-select mode. You can then select which connections the query
should refresh against.
When multiple connections are selected, these will all refresh concurrently. This
means the time taken to refresh against all queries will only be the time taken to
refresh against the slowest connection.
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If the query is refreshed against multiple connections, an extra column will be added
to the resulting dataset that identifies which connection the data was retrieved from.
This extra column by default will be called Connection, but you can change its name
on this screen.

Data Management
By default, when a query retrieves new data from the server, it will completely clear
the old data and build the dashboard with only the data returned in the last refresh.
However, on occasions you may want to alter this behaviour. For instance, if you are
building a dashboard that shows sales for the last three years, you could build your
query to only return order data that has been created since the last time the query was
returned. In this case, you want the query to add the new order data to the data
previously returned, that shows orders from the last three years.
To change a query to accumulate data on the next refresh, follow these steps;
Select the query you wish to accumulate data in the queries list

Select the Each time the query is refreshed, add the results to the existing data option.
You can optionally request that the data is cleared the next time the query is refreshed
(and then accumulated thereafter) by checking the Clear old data next time the query
is refreshed option. If you edit the query, the data will be cleared next time it is
refreshed.
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You can optionally apply a filter to the existing data before any new data is added. For
instance, if the query is returning this month’s orders, you may wish to filter out any
existing values for this month’s orders to ensure the figures are not greater than they
should be. To apply a filter, check the Apply a filter to the old data before adding new
data option. This will open the Define the Data Filter screen to allow you to define the
filter to apply to the data. You can modify an existing filter by pressing the filter
button.

Last Run Details
Last Run Details gives details of the date and time a query was last refreshed, and any
error messages returned by the refresh process. The Last Run Details screen is opened
by pressing the Last Run Details button in the Queries group of the Edit Dashboard
tab on the ribbon.
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The Last refresh details screen consists of a query selector, a connection list and a
details box that displays information on the last time a query was run against a
connection. This information can be particularly useful for queries set to refresh
automatically by the DataPA Enterprise Service.
There are also buttons to



initiate a further refresh of the query, and
to open the connection tab of the Dashboard Properties Screen
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Saving a dashboard
Saving a dashboard saves the queries in the dashboard, the data returned by the
queries and the definitions of the tabs and dashboard objects in a dashboard. Follow
these steps to save a dashboard:
1. Select Save or Save As from the File menu on the ribbon.
2. If prompted, enter the name of the file you wish to save the dashboard as.
NB. There may be circumstances where you wish to save the dashboard, but do not
want the data that it contains to be available when it is opened. You can ensure that all
the queries in the dashboard are refreshed when it is opened and before the dashboard
is rendered by selecting the Refresh query when dashboard is opened option for all
queries in the dashboard properties window.
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Publishing a Dashboard
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Publishing a Dashboard
To publish a dashboard, select Publish from the File menu on the ribbon.
Please note that, if security is enabled in your DataPA environment, then you need to
be logged in as a user belonging to a group with the "Members of this group can
publish content" permission item checked before you can access this screen
Note: To be able to publish a Dashboard to the DataPA Enterprise Service, a valid
Category and Title must be set within the Dashboard Properties window.
If the dashboard is correctly defined, you will see an information box informing you
that the application is publishing your dashboard. During this process, you can press
the Cancel button on the information box to cancel the publish process.
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Managing Published Content
The Manage Published screen is intended to maintain content which has been
published to the DataPA Enterprise Service.
Please note that, if security is enabled in your DataPA environment, then you need to
be logged in as a user belonging to a group with the "Members of this group can
publish content" permission item checked before you can access this screen.
To manage published content, press Manage Publish command in the Settings group
in the Application Settings tab of the Ribbon
There are currently three types of content that may be published from the various
components of the DataPA product suite to the DataPA Enterprise Service:




Queries from the MS Excel or Access add-ins
Dashboards from the DataPA Dashboard Designer
Reports from the DataPA Report Designer

The Refresh button will query the DataPA Enterprise Service and rebuild the list of
content in case it has been changed.
The Restart Auto Update button is only applicable for dashboards whose queries have
been set to refresh automatically. Selecting this option refreshes the query and sets the
start time in the Refresh Schedule screen to the current time.
The Open button will open the selected content, however this is context sensitive, it
will only be enabled if




You have a dashboard selected and the screen was launched from the
Dashboard Designer
You have a query selected and the screen was launched from the Excel /
Access add-in
You have a report selected and the screen was launched from the Report
Designer.

110

DataPA OpenAnalytics End User Training
The Delete button will remove the selected content from the DataPA Enterprise
Service.
The Up and Down buttons can be used to reorder the content.
If you right click on a dashboard, report or query on this screen when you will have
the option Copy Enterprise URL to Clipboard which will copy the URL you need
to view that content directly in DataPA Enterprise. This is particularly useful if you
are embedding content in a third party web application.
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Printing a dashboard
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Printing a dashboard
Follow these steps to print a dashboard:
1. Select Print from the File menu on the ribbon.
2. Select your print preferences. Each tab of your dashboard will be printed on a
separate page. As such, you can print specific tabs by opting to print specific
pages in the print dialog.
3. Press OK
Once a dashboard is opened, the tabs are rendered on demand. This means if you have
not printed a dashboard since it was opened, and not viewed all the tabs, the
dashboard may need to render one or more tabs before the dashboard can be printed.
If this is the case, you will see a print information box informing you that the
application is preparing your dashboard for printing, and the application will render
each tab that that requires rendering. During this process, you can press the Cancel
button on the information box to cancel the print process.
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Lesson 5 – Designing Reports
Introduction
In this lesson you will learn to create and modify the physical layout and formatting of
reports. We will also look at building reports from queries created in Excel, and
sharing queries created in the DataPA Reports Designer so they can be used in Excel.

Learning Objectives
When you complete this lesson you should be able to:













Create a new report in the DataPA Reports Designer.
Import and share queries to and from reports.
Identify the different elements of the report designer.
Create a simple report and format the layout.
Add groups to a report.
Add special fields to a report.
Add graphical elements to a report.
Add calculated fields to a report.
Add drill downs to a report
Creating a report with sub-reports
Publish a report to a DataPA Enterprise Service
Print and Export a report.

Prerequisites
Before you begin this lesson you should be able to:
 Open a report in the DataPA Report designer.
 Refresh a report in the DataPA Report designer.
 Create and save a query in Excel.
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Creating a New Report
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Creating a Report
As we discussed in the lesson above, a DataPA Report is built using a DataPA query.
When we create a report we can either create a new query for the report, or import an
existing query to use as the basis for the new report.
Follow these steps to create a new report from an existing query:
1. From the File menu select Create a New Report.
2. Press Next to bypass the Introduction Screen.
3. Select Copy an Existing Query.

4. Press Browse and select the query file on disk.
5. Complete the query wizard, making any changes to the query as
required.
6. Complete the Run Query Wizard to retrieve data for the report.
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To create a report from a new query, follow the steps above but select Create a New
Query instead of Copy a Existing Query.
To share a query from a report, so it can be opened and used in Excel follow these
steps:
1. Select Share Query from the Setup menu of the DataPA Reports
Designer.

2. Browse to the required directory, enter the name of the query and press
Save.
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The Report Designer
Field
Explorer

Report
sections
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The Report Designer
When you first enter the Report Designer panel, you will see the following sections:
Section
Description
Fields

This section allows you to browse and select fields and drag and
drop them onto sections of the report.

Page Header

This section represents the page header of the report. Anything
added to this section will be repeated at the top of every page of
the report.

Details

This section represents the details section of the report. Anything
added to this section will be repeated for each row of data
returned by the query.

Page Footer

This section represents the page footer of the report. Anything
added to this section will be repeated at the top of every page of
the report.

The following sections can be added by following the steps below:
1. Press the Group button on the toolbar in design mode.

2. Select the Section Options tag.
3. Select Include Report Header/Footer
Section
Description
Report Header

This section represents the report header. Anything added to this
section will appear once at the top of the report.

Report Footer

This section represents the report footer. Anything added to this
section will appear once at the bottom of the report.
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Adding fields to a Report
To add fields from the query to a report, follow these steps:
1. In the Fields box click the field you wish to add to the report, and drag
it to the required position in the details section of the report. Column
Headers will be automatically added to the Page Header Section.
2. Repeat step (1) for each field you wish to add to the report. You can
select multiple fields at once
You can preview the results of changes at any time by switching between design and
preview modes.

Changing the Orientation of the Report
Sometimes you will want to change the page size or orientation of the report from
Portrait to Landscape. Follow these steps to do this:
1. From the File menu, select Print Setup.
2. Select the page size and orientation from the Print Setup dialog box.

Changing the Height of Report Sections
Follow these steps to change the height of a report section:
1. Press and hold the right mouse button over the bar at the bottom of the
section
2. Drag it to the required size.
You can also automatically resize a section to fit the contents. To achieve this, follow
these steps:
1. Press the right mouse button over the bar at the bottom of the section.
2. Select Section Fit then Height from the popup menu. (N.B Selecting
Section Fit then Width will fit the width of the whole report to the
contents of the section).
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Resizing and Moving Fields in a Report
To resize a field on the report, follow these steps:
1. Press the left mouse button over the field to select it.

2. Move the mouse over one of the blue squares round the field, press the
left mouse button and drag it to the size you require.
To move a field, click the left mouse button over the field and drag it to the position
you require.
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Using Groups with Reports
Insert Summary

Insert Group
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Grouping Data
Often you will want to group your report data by one or more of the fields. The
DataPA Reports designer provides functionality to allow us to group data easily and
add summary fields for these groups.
To add a grouping to your data, follow these steps:
1. Click the Group Options button at the top of the report designer. The
icon for this is
2. Select the field you wish to group your report by.
3. Select whether you want the groups to be sorted in ascending or
descending order.
Notice this adds two new sections to your report.
Section

Description

<Field Name>
_GroupHeader

This section represents the group header. Anything added to this
section will be repeated for each group in the specified
grouping, and displayed above the group.

<Field Name>
_GroupFooter

This section represents the group footer. Anything added to this
section will be repeated for each group in the specified
grouping, and displayed below the group.
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Group options
To access the Group Options screen, select a group field in the Group Sections list,
then press options. Group Options allow set properties for your group that manage the
behaviour of the group sections in your report. You can determine the sort order of
your group, set whether or not the report attempts to keep each section for a particular
group item on one page, and if and when the group header is repeated.
Groups are sorted by the field they are
based on. You can choose the sort the
field in either Ascending or
Descending order by selecting the
appropriate group order.
For Date fields, you can choose to
group your data by day, month, year
or quarter..

You can use the Group Keep Together
options to set whether or not the
report attempts to keep each section
for a particular group item on one
page.
If Keep Group Data Together is checked, selecting All means the group header, detail
and group footer will print together on the same page. If Keep Group Data Together is
checked, selecting First Detail means the group header will print with the first detail
section on the same page or column.
The Repeat Group Header option
determines whether a group header
section should be printed again before
its associated detail section when the
detail section is broken across multiple
pages or columns.
The table below details the values you can choose for this option.
Value
None
Every Page with Data
Every Column
All
Every Page

Description
Do not reprint the group header.
Print the group header at the top of each page within the
group's detail sections.
Print the group header at the top of each column within the
group's detail sections.
Print the group header at the top of each column and page
within the group's detail sections.
Print the group header at the top of each page within the
group's detail section even if there is no data in the section.
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Adding a Summary Field to the Report
The DataPA Reports designer allows you to easily add summary fields to your report.
To add a summary field, follow these steps:
1. Click the Summary Field button at the top of the DataPA Report
2.
3.
4.
5.
6.

Designer. The icon for this button is
Draw the summary field on the report.
Enter a name for the summary field.
Select the data field you wish to summarize.
Select the type of summary you require.
Select either Grand Total or the group by which you want to
summarize the data.

Adding Text Objects to the Report
Often you will want to add fixed text objects to a report, as labels or titles. To add a
fixed text object, follow these steps:
1. Click the Label button at the top of the DataPA Report Designer. The
icon for this button is
2. Draw the label on the report.
3. Enter the text for your text object.
Text objects can be arranged and formatted in the same way as any other field or
object on the report.
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Using the Section Expert
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Using the Section Expert
The section expert allows you to change the appearance and behaviour of sections
within a report.
Follow these steps to access the section expert:
1. Select the Group Options button and then click on the Section Options
tab.
2. Select the section you wish to format.

3. Select the required options.
4. Press OK to save your changes.
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Adding Graphical Objects
to a Report
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Adding Images to a Report
To add an image to a report, follow these steps:
1. Select the Image button from the toolbar above the DataPA Report
designer. The icon for this button is
2. Draw the image onto the report where you would like it to appear
3. Browse to and select the picture you wish to insert into the report.
The image can be moved and resized in the report in the same way as any other
object.

Adding Lines or Boxes to a Report
To add a line or box to a report, follow these steps:
1. Select the Line button to insert a line (icon is
) or the Shape button
to insert a box (icon is
).
2. Draw the line or box onto the report and select the options you want for
the line or box.
The line or box can be moved and resized in the report in the same way as any other
object. To change the appearance of the line or box, follow these steps:
1. Press the left mouse button over the line or box to select it.
2. Press the right mouse button over the line or box and select Edit from
the popup menu.
3. Select the format options you require and press OK to save your
changes.
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Adding Special Fields to a Report
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Adding Special Fields to a Report
The DataPA Report designer provides some special fields such as page numbers, and
today’s date that you can use in your report.
Follow these steps to add a page number field to your report:
1. Select the Page Number button from the toolbar above the DataPA
Report designer. The icon for this button is
2. Draw the Page Number field onto the report to where you require it.
3. Select the type of page number you require.
4. Resize, position and format the Page Number field in the same way as
you would with an ordinary field.
Follow these steps to add a current date and time field to your report:
1. Select the Date & Time button from the toolbar above the DataPA
Report designer. The icon for this button is
2. Draw the Date & Time field onto the report to where you require it.
3. Select the type of date and time you require.
4. Resize, position and format the Date & Time field in the same way as
you would with an ordinary field.
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Adding Query Condition Parameters to a Report
If the Report Query contains Condition Parameters then DataPA provides query
condition descriptions in the DataPA Report Designer for each required field
condition you added to your query.

Follow these steps to add query condition descriptions to your report:
1. Select the Query Fields button from the toolbar above the DataPA
Report designer. The icon for this button is
2. Draw the Query Fields field onto the report to where you require it.
3. Select the Query Field you want on your report.
4. Resize, position and format the query condition description in the same
way as you would with a normal field.
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Calculated Fields
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Adding Calculated Fields to your Report
The DataPA Report Designer provides a rich array of functionality for creating
calculated fields from the data, summary and other calculated fields in your report. A
detailed look at how to build calculated fields is not covered in this course, however
we will cover the basics of how to access the calculated fields editor and use
calculated fields in your report.
To add a calculated field to your report, follow these steps:
1. Select the Calculated Fields button from the toolbar above the DataPA
2.
3.
4.
5.

Report designer. The icon for this button is
Draw the calculated field onto the report to where you require it.
Enter a name for the calculated field.
Enter the calculation you require for the field.
Resize, position and format the calculated field in the same way as you
would with a normal field.
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Graphs
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Adding Graphs to your report
The DataPA Report Designer provides a rich array of functionality for creating
graphs and charts from the data in your report.
To add a graph to your report, follow these steps:
1. Select the Graph button from the toolbar above the DataPA Report
designer. The icon for this button is
2. Select the field you want to use to summarise the data from the list tree
view on the left and select the top > button to move that field into the
‘On change of’ box.
3. Select the field you want to be summarised the list from the tree view
on the left and select the bottom > button to move that field into the
‘Show values’ box.
4. Select the Graph Appearance tab.
5. Select the graph type you want to use in this case using the Gallery
button
6. Set any other chart options as required
7. Click OK
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Drilldowns
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Adding Drilldowns to your report
The DataPA Report Designer allows users to add drilldowns to fields in their reports.
This allows users to create interactive reports with users able to move easily from
level of information to another. For example, a user might want to be able to drill into
customer information to see invoices or order for that customer on a separate report.
To add a drilldown to your report, follow these steps:
1.
2.
3.
4.
5.

Highlight the field you want to drilldown on and right click
Select ‘Add Drill Down’
Enter a name for the query the drilldown will use
Click Next and select the subject to be used for the drilldown
Click Next and add the conditions which will be used to joining the
drilldown report with it’s parent report
6. Click Next and select the fields to be used on the drilldown report
7. Click Next and select the fields that the data on the drilldown report
should be sorted by.
8. Click Next and then Finish
9. Design the drill down report just as you would a normal report
10. When finished designing the report use the ‘Close Drill Down’ button
to return to the parent report
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Sub Reports
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Adding sub reports to your report
DataPA allows reports to contain any number of child reports called sub reports.
Child reports, or Sub reports, are executed each time their parent section (the section
in which the Sub report is placed) is printed. Sub reports can be based on the same
data as the parent report, or child data based on a query containing multiple subjects,
with split results selected so the query returns more than one recordset.
To add a sub reports to your report, follow these steps:
1. If required, add one or more child subjects to the query your report is
based on, ensuring that any fields used to link subjects are included in
the fields (These fields will be used by the report designer to filter the
sub reports, so you will get unexpected grouping results without them),
and selecting Split Query Results in the query wizard.

2. Refresh the query. (This will be done for you when you finish the
query wizard).
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3. In design mode, select the sub reports button.

4. Select the subject you wish to add the sub report for and press Add.

5. Draw the sub report on to the parent report.
6. Right click on the sub report and press Edit Sub Report

7. Design the sub report (you can preview it as you go).
8. Close the sub report with the close report button
9. Preview the main report.
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Printing Reports
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Preparing Your Report to Print
Before you print your report, you should check the print setup as this will effect the
appearance and layout of your report.
To check your print setup, follow these steps:
1.
2.
3.
4.

Select Print Setup from the File menu.
Select the print options you require.
Press OK to save your changes.
Check your report in the Preview panel to see if the layout has
changed.

Printing Your Report
Follow these steps to print your report:
1. Select Print from the File menu.
2. Select the number of copies and pages you want to print.
3. Press OK to print the report.
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Publishing a Report
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Publishing a Report
To publish a report, select Publish from the File menu on the toolbar.
Please note that, if security is enabled in your DataPA environment, then you need to
be logged in as a user belonging to a group with the "Members of this group can
publish content" permission item checked before you can access this screen
Note: To be able to publish a report to the DataPA Enterprise Service, a valid
Category must be set within the Report Properties window.
If the report is correctly defined, you will see a publish information box informing
you that the application has published your report.
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Managing Published Content
The Manage Published screen is intended to maintain content which has been
published to the DataPA Enterprise Service.
Please note that, if security is enabled in your DataPA environment, then you need to
be logged in as a user belonging to a group with the "Members of this group can
publish content" permission item checked before you can access this screen
To manage published content, select Manage Publish from the Setup menu on the
toolbar.
Please note that, if security is enabled in your DataPA environment, then you need to
be logged in as a user belonging to a group with the "Members of this group can
publish content" permission item checked before you can access this screen.
There are currently three types of content that may be published from the various
components of the DataPA product suite to the DataPA Enterprise Service:




Queries from the MS Excel or Access add-ins
Dashboards from the DataPA Dashboard Designer
Reports from the DataPA Report Designer

The Refresh button will query the DataPA Enterprise Service and rebuild the list of
content in case it has been changed.
The Restart Auto Update button is only applicable for dashboards whose queries have
been set to refresh automatically. Selecting this option refreshes the query and sets the
start time in the Refresh Schedule screen to the current time.
The Open button will open the selected content, however this is context sensitive, it
will only be enabled if


You have a dashboard selected and the screen was launched from the
Dashboard Designer
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You have a query selected and the screen was launched from the Excel /
Access add-in
You have a report selected and the screen was launched from the Report
Designer.

The Delete button will remove the selected content from the DataPA Enterprise
Service.
The Up and Down buttons can be used to reorder the content.
If you right click on a dashboard, report or query on this screen when you will have
the option Copy Enterprise URL to Clipboard which will copy the URL you need
to view that content directly in DataPA Enterprise. This is particularly useful if you
are embedding content in a third party web application.
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Exporting Your Report
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Exporting Your Report
The DataPA Report designer provides functionality to export your report to a host of
different formats so you can view it from other applications.
To export your file, follow these steps:
1.
2.
3.
4.

Select Export from the File menu.
Select the type of export you want.
Enter the destination for the export.
Press OK to start the export.

NB. The Export option becomes enabled when a report's query has been run to
generate data.
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Appendix A - Scripting
Introduction
In this lesson you will learn how to use scripting in DataPA reports for more complex
tasks such as conditional formatting and adding ActiveX controls. The lesson will not
cover VBScript syntax in any depth.

Learning Objectives
When you complete this lesson you should be able to:







Accessing report scripts
The script structure
Adding ActiveX controls to a report
Accessing object properties
Referencing report objects in scripts
Referencing data in scripts

Prerequisites
Before you begin this lesson you should be able to:




Open and design report in the DataPA Report designer.
Refresh a report in the DataPA Report designer.
A familiarity with VBScript is an advantage.
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Accessing report scripts
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Accessing Report Scripts
All DataPA reports have scripts behind them that control the behaviour of the report
when it is rendered. To access the scripts follow these steps:
1. Open a report.
2. Select design
3. Click on the View Script button.

4. Select the appropriate object, and event in the combo boxes, then enter
your code. (Objects and events are detailed in the table on the next
page).
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Object
Description
ActiveReports Document There is a single active reports object in each report.
This object refers to the report itself, and has related
events that can be used to modify properties or
behaviour for the whole report.
There is a section object for each section of the report.
Section
The section events allow you to modify behaviour or
properties for each instance of the section.
Event
OnDataInitialize

Object
Report

OnReportStart
OnReportEnd
OnPageStart

Report
Report
Report

OnPageEnd

Report

OnHyperLink

Report

OnfetchData

Report

OnNoData

Report

OnPrintProgress
OnError

Report
Report

OnFormat

Section

OnBeforePrint

Section

OnAfterPrint

Section

Description
Event fired before ReportStart to add custom
fields to report fields collection. In a DataPA
report, the recordset is opened and the
recordset fields are added to the custom
Fields collection then the DataInitialize event
is fired so that new custom fields can be
added.
Occurs before a report starts processing.
Occurs when report finishes processing
During the report's processing, this even
Occurs before a page is rendered.
Occurs after each page in the report is
rendered.
This event fires when a hyperlink is clicked.
It can be used to redirect a hyperlink or
prevent the link from activating.
Event is fired every time a new record is
processed. Use to set the values of custom
fields that were added in the Data Initialize
event.
Occurs when the reports recordset is empty.
There is no data to be processed.
Fired for each page during a print job.
Occurs as the result of a DataPA Reports
error.
Fired after the data is loaded and bound to
the fields, but before the section is laid out
for printing. You can use this event to
modify the layout of the section or any of the
controls on it. This is the only event in which
you can modify the height of the section.
Fired before the section is rendered. You can
use this event to modify the values of the
controls before they are printed. Any
changes that are made here will not affect the
height of the section.
Fired after the section is Printed. You can
use this event to update any counters that you
need to use after the report is completed.
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Adding ActiveX Controls
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Adding ActiveX Controls
You can add any registered ActiveX control to a DataPA report. Follow the steps
below to add an ActiveX control to a report:
1. Open a report.
2. Select design mode.
3. Select the ActiveX control button ( )
4. Select the control you want to add to the report.
5. Draw the control on to the report.
To view the properties of an ActiveX, or any object, follow these steps:
1. Select the object.
2. Right click on the toolbar and select Property ToolBox
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Referencing Objects and Data
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Referencing Objects and Data
In order to achieve anything useful with report scripting, we need to be able to
reference objects on the report, their properties and the data of the report.
Referencing Objects
Reports can be referenced in the script using the identifier Rpt. Each report has a
sections collection that contains each section on that report. Each section on a report
has a controls collection that contains every object in the section. As such, the syntax
to reference a control in a report is:
Rpt.Sections.item("<SectionName>").Controls.item("<ControlName>")

Where <SectionName> is the name of the section and <ControlName> is the name of
the control as referenced in the Property Toolbox.
Referencing Data
Reports can be referenced in the script using the identifier Rpt. Each report has a
fields collection that contains the value of each field on the report when referenced.
As such, the syntax to reference a field value in a report is:
Rpt.Fields.Item("<FieldName>")

Where <FieldName> is the name of the field.
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Introduction
Subjects are the foundation for all queries users will create with DataPA. As such they
define the scope, structure and efficiency of the information that is available through
the product. This lesson shows in detail how build subjects by combining the DataPA
subject wizard with Progress ABL business logic structures.

Leaning Objectives
When you complete this lesson, you should be able to:







Create freeform subject using the subject wizard.
Modify and delete existing subjects
Add calculated columns to a freeform subject.
Create, administer and use dynamic functions with a freeform subject.
Create Business Logic subjects from Progress Dynamic Functions
Create SDO subjects

Prerequisites
Before you begin this lesson you should be able to:




Use DataPA to create and run queries and reports
Write ABL business logic.
Understand the use of Dynamic functions and super procedures.
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Creating Freeform Subjects
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Introduction
Users create queries with DataPA to extract data for their reports and exports. Subjects are the basic
building blocks for queries and all DataPA Queries are based on one or more Subjects. As such,
Subjects are a way of hiding the underlying database complexity and controlling the Query building
process. They provide a user friendly view of the data and prevent the use of unrelated tables,
inefficient sorting on non-index fields, inefficient finds on non-index columns and the display of
sensitive or system data. Each subject is related to a single system. Subjects can either be built using
the links created for a system, in which case it is a freeform query, or using some bespoke ABL
business logic on the server, in which case it is a Business Logic or SDO subject. First we will look at
creating, modifying and deleting a simple freeform subject.

Creating a freeform subject
Follow these steps to create a freeform subject:
1. Open the DataPA Analytics Engine screen and ensure your System is selected.
2. Select File  New or Click on the New System button on the Ribbon
3. Press Next, then enter a name and description for the subject.
4. Press Next, then select the system you wish to create a subject for
5. Press Next, press Next again to create a freeform subject

6.
7.

8.

Select the tables you require for the subject (if you do not want to use the default link for a
table, press Modify Link to modify the link for this subject only) and press Next
Enter any filter conditions to filter the subject. These filter conditions are similar to those that
can be entered when creating a query described in lesson 2, however they are not visible to the
end user and are included with any query created using this subject. Press Next.
Select the columns you wish to be available for this subject.
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9.

Press Next (we will cover calculated columns later in this lesson), then for each column,
specify a user friendly name, whether or not it can be used as a condition and whether or not it
can be used for sorting. NB By default, only indexed fields will be allowed as conditions and
sort columns.
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Adding Calculated Columns
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Introduction
Often you will want to add columns to a freeform subject that must be derived from a calculation
rather than being directly available from the database columns. This can be done by adding calculated
columns in the subject wizard.

Adding Calculated columns to a Freeform Subject.
Follow the steps below to add a calculated column to an existing subject:
1. Open the DataPA Analytics Engine screen and select the System in the Tree view.
2. Open the Subjects node
3. Select the Subject you wish to modify.
4. Select the Calculated Columns Tab.
5. Press Add
6. Enter a name for the calculated column
7. Select the appropriate Progress data type
8. Enter the Progress expression to evaluate the
calculated column. The expression must be a single
valid Progress expression that resolves to a single
value of the data type selected. If you want to
include any database columns in the expression,
double-click the column in the Available Columns
list-box.
9. Press OK
10. Select the Column Attributes Tab
11. Select each calculated field in the Available
Columns Treeview under <Calculated Columns>
section, then enter an appropriate label in the
Column Label text box.
12. Press Save Changes on the Ribbon
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Introduction
Dynamic functions can be used in DataPA to create complex calculated columns for freeform subjects
and, if the function returns a handle to a temp-table, for creating Business Logic subjects.

Preparing Dynamic Functions for use by DataPA
Before you can use a dynamic function in DataPA you must complete the following
steps:
1.
2.
3.

Create a Progress structured procedure that containing the functions you wish to use from
DataPA
Create a Progress procedure to add the structured procedure containing your functions to the
super procedure stack and add this as the AppServer startup procedure.
Add calculated columns that call the dynamic functions to your subjects.

Each of these steps will be described in detail below.
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Creating a Structured Procedure
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Introduction
In order to use a dynamic function in DataPA we must first write the functions as Progress
ABL functions. The functions can take any number of input parameters, and return a single
value.

Creating a Structured Procedure
Follow these steps to create a structured procedure library that can be used for dynamic
function calls from DataPA:

Open the Progress AppBuilder
Select FileNew, ensure the
Procedures tab is
selected, select Structured Procedure
and press
OK
From the Section combo box of the Section Editor, select functions.
Press OK to confirm you want to create a new function.
Enter the name of the function you want to create and select the appropriate
data type, then press OK.
Enter the code for your function, including any input parameters and setting
the return value. (see example below).
1.

Save the structured procedure somewhere in the PROPATH of your AppServer.

RETURNS DECIMAL ( INPUT iCusnum AS INTEGER ) :
/*-------------------------------------------------------------Purpose:
Notes:
--------------------------------------------------------------*/
DEFINE VARIABLE dOrderValue AS DECIMAL
NO-UNDO INITIAL 0.
FOR EACH Order WHERE Order.custnum = iCusnum NO-LOCK:
FOR EACH orderline OF order NO-LOCK:
dOrderValue = dOrderValue + extendedprice.
END.
END.
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RETURN dOrderValue.

/* Function return value. */

END FUNCTION.
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Creating functions for DataPA
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Introduction
Dynamic functions can be used in DataPA for creating Business Logic subjects. This section details
how to write a Dynamic function that can be used in a DataPA Business Logic Subject.

Creating Dynamic Functions for Business Logic Subjects
To add a Dynamic Function that can be used from a DataPA Business Logic Subject, follow these
steps:
1. In the definitions section of your Structured Procedure, add a definition for the Temp-Table
you wish to return. Make sure you add the RCODE-INFORMATION option to your temptable definition so the format and labels are passed to DataPA.
DEFINE TEMP-TABLE ttSalesRepPerformance NO-UNDO RCODE-INFORMATION
FIELD SalesRep
LIKE SalesRep.SalesRep
FIELD RepName
LIKE SalesRep.RepName
FIELD YEAR
AS INTEGER FORMAT "9999" LABEL "Financial Year"
FIELD AnnualQuota AS DECIMAL FORMAT ">>>,>>>,>>9.99" LABEL "Annual Quota"
FIELD TotalSales AS DECIMAL FORMAT ">>>,>>>,>>9.99" LABEL "Total Sales"
FIELD Percentage AS DECIMAL FORMAT ">,>>>,>>9.99"
LABEL "Percent Achieved"
INDEX idx1 IS PRIMARY IS UNIQUE SalesRep YEAR.

2.
3.
4.
5.
6.

Create a new function, with a return type of handle.
Define any input parameters for your temp table.
Enter code to empty the temp-table.
Enter code to populate the temp-table.
Return the handle for the temp-table.
RETURNS HANDLE
( INPUT iStartYear AS INTEGER,
INPUT iEndYear
AS INTEGER ) :
/*-----------------------------------------------------------------------------Purpose:
Notes:
------------------------------------------------------------------------------*/
DEFINE VARIABLE iYear
AS INTEGER
NO-UNDO.
EMPTY TEMP-TABLE ttSalesRepPerformance.
REPEAT WITH iYear = iStartYear TO iEndYear:
/* Create records from salesrep */
FOR EACH SalesRep NO-LOCK:
CREATE ttSalesRepPerformance.
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ASSIGN
ttSalesRepPerformance.SalesRep = SalesRep.SalesRep
ttSalesRepPerformance.RepName = SalesRep.RepName
ttSalesRepPerformance.YEAR
= iYear
ttSalesRepPerformance.AnnualQuota = SalesRep.MonthQuota[1]
+ SalesRep.MonthQuota[2]
+ SalesRep.MonthQuota[3]
+ SalesRep.MonthQuota[4]
+ SalesRep.MonthQuota[5]
+ SalesRep.MonthQuota[6]
+ SalesRep.MonthQuota[7]
+ SalesRep.MonthQuota[8]
+ SalesRep.MonthQuota[9]
+ SalesRep.MonthQuota[10]
+ SalesRep.MonthQuota[11]
+ SalesRep.MonthQuota[12].
END.
/* Add up order value */
FOR EACH Order WHERE Order.OrderDate >= DATE(1,1,iYear)
AND Order.OrderDate <= DATE(12,31,iYear)
NO-LOCK:
FIND ttSalesRepPerformance
WHERE ttSalesRepPerformance.SalesRep = Order.SalesRep
AND ttSalesRepPerformance.YEAR
= iYear NO-ERROR.
IF AVAILABLE ttSalesRepPerformance THEN DO:
FOR EACH OrderLine OF Order NO-LOCK:
ttSalesRepPerformance.TotalSales = ttSalesRepPerformance.TotalSales +
OrderLine.ExtendedPrice.
END.
END.
END.
/* Work out percentage */
FOR EACH ttSalesRepPerformance:
IF ttSalesRepPerformance.TotalSales = 0
THEN ttSalesRepPerformance.Percentage = 0.
ELSE ttSalesRepPerformance.Percentage = (ttSalesRepPerformance.TotalSales
/ ttSalesRepPerformance.AnnualQuota).
END.
END.

FOR EACH ttSalesRepPerformance:
DISP ttSalesRepPerformance WITH 1 COLUMN.
END.
RETURN TEMP-TABLE ttSalesRepPerformance:HANDLE.
END FUNCTION.
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Introduction
In order to use the functions defined in structured procedure from DataPA, they need to be
placed into memory on the server and made available to the AppServer. To do this, we use
an AppServer startup procedure, which is called each time an agent starts, to run the
structured procedure persistently and place it on the super-procedure stack of the AppServer
agent session.

Adding the function procedure to the super procedure stack
Follow these steps to add the structured procedure that contains the function definitions to the
super procedure stack:
1. Open the Progress AppBuilder
2. Select Tools New Procedure Window
3. When an AppServer agent runs a startup procedure, it passes in a character variable. Therefore
your procedure must start with an input character variable definition as below:
DEFINE INPUT PARAMETER startup-data AS CHARACTER NO-UNDO.
4.

Define a progress handle variable we can use to store the procedure handle:
DEFINE VARIABLE hProc AS HANDLE

6.

NO-UNDO.

Run the structured procedure persistently, storing the handle in the defined variable, and add it
to the session super procedure stack.
RUN OrderFunctions.p PERSISTENT SET hProc.
SESSION:ADD-SUPER-PROCEDURE(hProc).

7.
8.
9.
10.
11.
12.
13.

Save the procedure as startup.p somewhere in the PROPATH of the AppServer.
Open Progress Explorer
Open the properties screen for your AppServer
Select Agent  Advanced Features
Enter startup.p in the Startup text box.
Press OK
Restart the AppServer.

150

DataPA OpenAnalytics End User Training

Calling Dynamic Functions from DataPA

© DataPA

Introduction
Once a function procedure is available on the AppServer, it can be used in a DataPA subject
to create calculated columns.

Using Dynamic Functions in Calculated Columns
Follow the steps below to add a calculated column to an existing subject:
1. Open the DataPA Analytics Engine screen and ensure your System is selected in the Tree
View
2. Select the Subjects Node.
3. Select the subject you wish to modify.
4. Select the Calculated Columns Tab
5. Press Add
6. Enter a name for the calculated column.
7. Select the Progress data type that was used when
the function was defined.
8. Enter the Dynamic Function call. The call must
be in the following syntax:
DYNAMIC-FUNCTION ( function

[ , parameters ] )

9. Press OK
10. Select the Column Attributes Tab
11. Select each calculated field in the Available
Columns Tree view under <Calculated Columns>
section, then enter an appropriate label in the
Column Label text box.
12. Press Save Changes on the Ribbon
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Creating Business Logic Subjects

© DataPA

Introduction
In addition to creating freeform subjects, DataPA also allows the creation of
subjects from Business Logic functions running persistently on the AppServer.

Creating Business Logic Subjects
Follow these steps to create an SDO subject:
1. Open the DataPA Analytics Engine screen and ensure your System is selected.
2. Select File  New Subject or click on the New Subject button on the Ribbon.
3. Press Next, then enter a name and description for the subject.
4. Select the System and press Next
5. Select Create Business Logic Subject and select the persistently running business logic
procedure you wish to use.

6.

Press Next.
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7.

For each input parameter of the business logic function, specify whether or not you want the
subject to use the stored value or prompt the user for an input parameter. If you are going to
prompt the user, you need to enter a name and description for the parameter and specify
whether or not the parameter is mandatory. If the parameter is not mandatory, and the user
chooses to skip the parameter when they run a query, a null value will be passed to the
business logic procedure.

8.

In the Test Execution Parameter Wizard Step, enter a value for each input parameter for your
function, then press Finish.

9. Press Next, and enter any further conditions you wish to set against the subject.
10. Press Next and select which columns you wish to be available with the subject.
11. Press Next, then for each column, specify a user friendly name, whether or not it can be used
as a condition and whether or not it can be used for sorting.
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Creating SDO Subjects
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© DataPA

Introduction
In addition to creating freeform subjects, DataPA also allows the creation of
subjects from ADM2 and Dynamics Smart Data Objects (SDO’s). SDO’s form
the basis of the Progress ADM2 and Dynamics frameworks and are designed
to provide read and write access to a database in a distributed environment.
For DataPA, SDO’s provide a consistent method of accessing any server-side
business logic to read data, allowing DataPA to support almost any complex
reporting requirement. SDO’s are Progress procedures and can be created
quickly and simply using the Progress wizard.

Creating SDO Subjects
Follow these steps to create an SDO subject:
1. Open the Progress AppBuilder and connect to any
databases required.
2. Select FileNew
3. Make sure SmartObjects is checked, select
SmartDataObject and press OK
4. Press Next
5. Press Next to get to the ABL Query screen
6. Press Define Query
7. Use the Query Builder to build your query.
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8. Press Next
9. Press Add Fields
10. Select the fields you wish to be available in the query and press OK.

11. Press Calculated Field to enter a calculated field.
12. Use the Calculated Field Editor to build a calculated field expression and press OK.
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13. Select the data type and enter a name, label, column label and format for each calculated field.
Press OK.

14.
15.
16.
17.
18.
19.
20.

Press Next and Finish.
Save the SDO in the PROPATH of the AppServer.
Open the DataPA Analytics Engine screen and ensure your System is selected.
Select File  New System or click on the New System button on the Ribbon.
Press Next, then enter a name and description for the subject.
Select the System and press Next
Check Create Smart Data Object Subject, and enter the SDO name. Press Next

21. Press Next, then enter a name and description for the subject.
22. For each field, enter a column label, and select whether or not it can be used for sorting and
conditions.
23. Press Next, press Finish.
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